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AKVIS ARTWORK 14.0 | VIELSEITIGE SAMMLUNG VON MALTECHNIKEN

AKVIS ArtWork imitiert verschiedene Maltechniken. Damit machen Sie aus jedem digitalen Foto ein persönliches Kunstwerk!

Die Software ist der perfekte Ausgangspunkt für Ihren kreativen Ausdruck! Das Programm kombiniert Spitzentechnologie mit
einem künstlerischen Ansatz und präsentiert sich als ultimativer virtueller Künstler. Die Verwandlung eines Bildes in ein Gemälde
geschieht vor Ihren Augen – Sie können die Entstehung eines Kunstwerks in Echtzeit verfolgen!

Das Programm bietet diese Mal- und Zeichenstile an: Ölgemälde, Aquarell, Gouache, Comic, Tintenzeichnung,
Linolschnitt, Schablonenkunst, Pastell und Pointillismus. Sie können einzeln oder in Kombination verwendet werden.

    

    

Mit der Software lassen sich Ihre Bilder auf einfache und vielseitige Weise mit künstlerischen Effekten versehen.

Erstellen Sie ein Ölporträt Ihres Freundes, ein Landschaftsgemälde oder ein Stillleben. Entdecken Sie neue Genres und
Kunstrichtungen!

Sie können dann das Ölgemälde drucken und einrahmen lassen, sodass es echt aussieht. Und wenn Sie es dazu noch mit Lack
überziehen, wird das Bild wie ein Ölgemälde vorkommen. Erstellen Sie eine  Grußkarte oder ein Poster, und Sie haben ein
wundervolles Geschenk für Ihre Freunde oder Ihre Familie.

Keine Pinsel oder Farben sind erforderlich. Starten Sie einfach ArtWork und lassen Sie Ihrer Kreativität freien Lauf!

Junge Künstler und Kunstlehrer können ArtWork verwenden, um ihre Malfähigkeiten zu perfektionieren. Wenn man sich zu sehr
auf Details konzentriert, kann man das Bild mit ArtWork vereinfachen und das Bearbeitungsergebnis als Vorbild für sein eigenes
Gemälde benutzen.

Effekte und Funktionen:

Der Ölgemälde-Effekt verwandelt Ihre Fotos in realistische Ölgemälde. Ob ein Ölporträt oder eine Landschaftsmalerei, wird
das Programm Ihre Ideen erfolgreich umsetzen. Selbst mit den Standardeinstellungen lassen sich gute Ergebnisse erzielen, die
sehr nah an Handmalerei heranreichen. Passen Sie die Parameter an, um verschiedene Malstile auszuprobieren. Für
diejenigen, die mehr Flexibilität brauchen, gibt es ein Werkzeug Richtung der Pinselstriche, das die Leitlinien für die Striche
festlegt. Dieses halbautomatische und intelligente Tool gibt Ihnen die volle Kontrolle über die Striche!
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Der Aquarell-Effekt verwandelt Ihre Fotos in Aquarellbilder. Ein Aquarell ist ein Malen mit wasserlöslichen Farben und gehört
zu den ältesten Maltechniken. Die Farben werden auf feuchtes Papier mit einem weichen Pinsel aufgetragen. Im Vergleich zum
Ölgemälde entsteht dadurch kein Relief, dafür aber ein weicher Übergang zwischen den Farben.
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Mit dem Gouache-Effekt können Sie aus einem Foto ein Gouache-Bild erstellen. Gouache ist eine sehr vielseitige Maltechnik,
die dichte intensive Farben verwendet. Die Farben zeichnen sich durch Brillanz und Deckkraft aus. Durch die hohe Deckkraft
können Sie außergewöhnliche Effekte erzielen, die mit Aquarellfarben nicht erreichbar sind. Diese Technik ist in der
Dekorationsmalerei und bei der Erstellung von Farbskizzen und Zeichnungen weit verbreitet.

Der Comic-Effekt erstellt Bilder im Comic-Stil. Das Programm reduziert die Töne des Fotos und betont seine Konturen, damit
es wie ein Comic bzw. ein Cartoon aussieht. Sie können einen Comicstrips oder ein originelles Poster mit Ihren Party-Fotos
erstellen.
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Bei dem Tintenzeichnung-Effekt wird die Technik imitiert, bei der farbige Tinten mit einer Feder oder einem Kugelschreiber auf
Papier aufgetragen werden. Es ist möglich, die Farbe der Zeichnung und die Hintergrundfarbe zu bestimmen. Das Ergebnis ist
eine zeichnerische Darstellung der Konturlinien.
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Der Linolschnitt-Effekt imitiert eine graphische Technik, bei der in eine Linoleumplatte ein Negativmuster geschnitten wird.
Dank dem Kontrast zwischen Schwarz und Weiß sind die Linolschnitte durch die große Ausdruckskraft gekennzeichnet. Dieser
Effekt ist ideal für Architekturbilder und Naturszenen geeignet.

Der Schablonenkunst-Effekt verwandelt ein Bild in eine Schablonenzeichnung mit kontrastreichen Konturen. Schablonieren ist
eine Technik zum Reproduzieren von Designs, indem Tinte oder Farbe über in Karton, Kunststoff oder Metall geschnittene
Löcher auf die zu dekorierende Oberfläche aufgetragen wird. Mit dem Programm können Sie einen ausdrucksstarken
monochromen Druck erstellen. Es ist möglich, Mitteltonbereiche hinzuzufügen und ein Schraffur- oder Pop-Art-Muster
anzuwenden. Verleihen Sie Ihrem Foto einen dramatischen Look!
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Der Pastell-Effekt (in Deluxe und Business-Lizenzen erhältlich) imitiert eine Maltechnik, die die Lücke zwischen Malerei und
Zeichnung auffüllt. Die pulvrigen Pastellstifte erzeugen weiche Striche, durch welche das Papier durchscheint.
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Der Pointillismus-Effekt, der für  Deluxe- und Business-Lizenzen verfügbar ist, heißt Punkt-um-Punkt-Malerei, bei der
Farbpunkt neben Farbpunkt gesetzt wird. Diese Stilrichtung gilt als Weiterführung des Impressionismus, die Kunst des
sinnlichen Eindrucks darstellte und der modernen Kunst den Weg bereitete. Die Pointillismus-Technik ist kompliziert und
aufwendig, aber mit AKVIS ArtWork können Sie digitale Meisterwerke mit nur einem Klick erstellen!

Es ist möglich, mehrere Effekte zu kombinieren, um einzigartige Bilder zu erstellen.

Die Software stellt einsatzbereite Presets zur Verfügung, die Ihnen dabei helfen sollen, sich schnell mit dem Programm
vertraut zu machen. Sie können unverändert oder modifiziert angewendet werden. Sie können Ihre Lieblingseinstellungen als
Preset speichern. Es ist möglich, Ihre Presets zu importieren bzw. zu exportieren.
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Damit das Gemälde noch realistischer wirkt, können Sie die Malerei mit einer Leinwand versehen. Man kann die Texturen aus
der Texturbibliotek benutzen (rauhe Oberfläche wie Leinen, Wellenpapier usw.) oder eine eigene Textur ins Programm laden.
Außerdem können Sie Ihr Kunstwerk personalisieren, indem Sie es mit einer Signatur versehen. Um Ihrem Gemälde den letzten
Schliff zu geben, fassen Sie es in einen Bilderrahmen.

Durch die Unterstützung der Stapelverarbeitung kann man mit dem Programm Video in ein Cartoon umwandeln. Es kann viel
Spaß bereiten, einen Trickfilm aus einem Hausvideo zu erstellen.

Einige Stile bieten Werkzeuge für Nachbearbeitung an. können Sie die Pinselstriche manuell korrigieren.

AKVIS ArtWork steht in zwei Versionen zur Verfügung als eigenständige Anwendung (Standalone-Programm) und als
Zusatzprogramm (Plugin).

Die Plugin-Version ist mit AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro u.a. kompatibel
(Kompatibilität prüfen).

Die Funktionalität des Programms hängt vom Lizenztyp ab. Während der Testperiode können Sie alle Optionen testen und
entscheiden, welcher Lizenztyp Ihren Bedürfnissen am besten entspricht.
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INSTALLATION UNTER WINDOWS

Nachfolgend finden Sie Anweisungen zur Installation der Programme von AKVIS unter Windows. Wir haben AKVIS ArtWork als
Beispiel genommen. Andere AKVIS-Programme lassen sich auf die gleiche Weise installieren.

 

Sie müssen über Administratorrechte verfügen, um das Programm auf Ihrem Computer zu installieren.

Bevor Sie die AKVIS-Plugins installieren, vergewissern Sie sich bitte, dass der Bildeditor, in dem Sie die Plugins installieren
möchten, geschlossen ist. Oder führen Sie den Bildeditor nach der Installation des Plugins erneut aus.

 

1. Starten Sie die ausführbare Setupdatei (mit .exe-Dateiendung).
2. Wählen Sie die Sprache aus und klicken Sie auf Installieren, um den Installationsvorgang zu starten.
3. Um den Installationsvorgang fortzusetzen, müssen Sie die Lizenzbedingungen durchlesen und akzeptieren.

Aktivieren Sie das Kontrollkästchen "Ich stimme den Bedingungen der Lizenzvereinbarung zu" und klicken Sie auf
Weiter.

4. Um das Plugin zu installieren, wählen Sie Ihre Bildbearbeitungssoftware aus der Liste aus.

Um die Standalone-Version zu installieren, stellen Sie sicher, dass das Kontrollkästchen Standalone aktiviert ist. 
Um eine Verknüpfung des Programms auf dem Desktop zu erstellen, aktivieren Sie den Punkt  Verknüpfung auf
Desktop.

Klicken Sie auf die Schaltfläche Weiter.
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5. Klicken Sie auf die Schaltfläche Installieren.

6. Die Installation ist gerade im Gange.
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7. Die Installation ist beendet.

Sie können AKVIS Newsletter abonnieren, um Informationen über neue Produkte und spezielle Angebote aus erster
Hand zu erhalten. Geben Sie Ihre Email-Adresse ein.

8. Klicken Sie auf Fertig stellen, um das Setup zu beenden.

Nach der Installation der Standalone-Version von AKVIS ArtWork sehen Sie einen neuen Eintrag im Menü Start: AKVIS -
ArtWork. Auf dem Desktop erscheint das Symbol der Verknüpfung, wenn Sie während der Installation das Kästchen
Verknüpfung auf Desktop aktiviert haben.

Nach der Installation der Plugins-Version von ArtWork sehen Sie einen neuen Eintrag im Filter/Effekte-Menü Ihrer
Bildbearbeitungssoftware. Z.B. in Photoshop: Filter -> AKVIS –> ArtWork, in AliveColors: Effekte -> AKVIS –> ArtWork.
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INSTALLATION UNTER MAC

Befolgen Sie die Anweisungen zur Installation der AKVIS-Software unter Mac. Wir haben AKVIS ArtWork als Beispiel
genommen. Andere AKVIS-Programme lassen sich auf die gleiche Weise installieren.

Sie müssen über Administratorrechte verfügen, um das Programm auf Ihrem Computer zu installieren.

 

1. Öffnen Sie die virtuelle dmg-Disk:

- akvis-artwork-app.dmg, um die eigenständige Standalone-Version zu installieren.

- akvis-artwork-plugin.dmg, um die Plugin-Version in einem Bildbearbeitungsprogramm zu installieren.

2. Lesen Sie die Lizenzvereinbarung und klicken Sie auf Akzeptieren, wenn Sie die Bedingungen annehmen.

3. Finder öffnet sich und Sie sehen einen Ordner mit Dateien: AKVIS ArtWork Application oder AKVIS ArtWork Plugin.

 

4. Um die Standalone-Version zu installieren, ziehen Sie AKVIS ArtWork Application in den Ordner Programme oder ein
Verzeichnis Ihrer Wahl.

Um die Plugin-Version zu installieren, ziehen Sie den ganzen Ordner AKVIS ArtWork Plugin in den Plug-Ins Ordner
Ihres Bildbearbeitungsprogramms:

AliveColors: Sie können den Ordner für Plugins in den Optionen des Programms auswählen.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC.

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins.

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins unter Mac
(klicken um zu vergrößern)

Nach der Installation des Plugins AKVIS ArtWork sehen Sie einen neuen Eintrag in dem Filter/Effekte-Menü Ihres
Bildbearbeitungsprogramms. Wählen Sie in Photoshop: Filter -> AKVIS -> ArtWork, in AliveColors: Effekte -> AKVIS ->
ArtWork aus.

Führen Sie die Standalone-Version aus, indem Sie im Finder auf das entsprechende Symbol doppelklicken.

Sie können das AKVIS-Programm auch über die  Photos-App ausführen, indem Sie den Befehl  Bild -> Bearbeiten mit
auswählen (in High Sierra und späteren Versionen von macOS).

 

AKVIS ArtWork

15

http://akvis.com/img/examples/artwork/install-software/setupmac4-b.jpg


INSTALLATION UNTER LINUX

Folgen Sie den Anweisungen, um die AKVIS-Software unter Linux zu installieren. Wir haben AKVIS ArtWork als Beispiel
genommen. Andere AKVIS-Programme lassen sich auf die gleiche Weise installieren.

Sie können nur die eigenständigen Anwendungen von AKVIS auf Computern mit Linux-Betriebssystem verwenden. Wir arbeiten
an der Plugin-Kompatibilität.

Hinweis: Die AKVIS-Programme sind mit Linux kernel 5.0+ 64-Bit kompatibel. Sie können die Kernel-Version mit dem
Befehl uname -srm herausfinden.

AKVIS-Installer sind für mehrere Linux-Distributionen verfügbar:

► DEB-Paket: Debian/Ubuntu

► RPM-Paket: Red Hat/CentOS/Fedora

► openSUSE

 

Installation auf Debian-basierten Systemen:

Hinweis: Sie benötigen apt-install- oder apt-get-Berechtigungen, um Software zu installieren.

1. Führen Sie das Terminal aus.
2. Erstellen Sie ein Verzeichnis zum Speichern von Schlüsseln: 

sudo mkdir -p /usr/share/keyrings
3. Laden Sie den Schlüssel herunter, mit dem das Repository signiert wurde: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
oder wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Fügen Sie das Repository der Liste hinzu, in der das System nach zu installierenden Paketen sucht: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Aktualisieren Sie die Liste der bekannten Pakete: 
sudo apt-get update

6. Installieren Sie AKVIS ArtWork: 
sudo apt-get install akvis-artwork

7. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

8. Für automatische Updates verwenden Sie den Befehl: 
sudo apt-get upgrade

So entfernen Sie das Programm: 
sudo apt-get remove akvis-artwork --autoremove

 

Installation auf RPM-basierten Systemen (CentOS, RHEL, Fedora):

1. Führen Sie das Terminal aus.
2. Registrieren Sie den Schlüssel, mit dem das Repository signiert wurde: 

sudo rpm --import https://akvis.com/akvis.asc
3. Fügen Sie das Repository dem System hinzu: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Aktualisieren Sie die Paketliste:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf update

beim Verwenden des yum-Paketmanagers: 
sudo yum update

5. Installieren Sie AKVIS ArtWork:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf install akvis-artwork

beim Verwenden des yum-Paketmanagers: 
sudo yum install akvis-artwork

6. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

7. Für automatische Updates verwenden Sie den Befehl:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf upgrade
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beim Verwenden des yum-Paketmanagers: 
sudo yum upgrade

8. So entfernen Sie das Programm:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf remove akvis-artwork

beim Verwenden des yum-Paketmanagers: 
sudo yum remove akvis-artwork

 

Installation auf openSUSE.

1. Führen Sie das Terminal aus.
2. Melden Sie sich als Root-Benutzer an.
3. Fügen Sie den Schlüssel hinzu, mit dem das Repository signiert wurde: 

rpm --import http://akvis.com/akvis.asc
4. Fügen Sie das Repository dem System hinzu: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Aktualisieren Sie die Paketliste: 

zypper ref
6. Installieren Sie AKVIS ArtWork: 

zypper install akvis-artwork
7. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

8. Für automatische Updates: 
zypper update

So entfernen Sie das Programm: 
zypper remove akvis-artwork

 

Um die Programmoberfläche korrekt anzuzeigen, empfiehlt es sich, den Compton oder Picom Composite-Manager zu
installieren.

 

AKVIS ArtWork

17



SO AKTIVIERT MAN AKVIS SOFTWARE

Achtung! Während des Aktivierungsvorgangs muss Ihr Computer mit dem Internet verbunden sein.

Wenn Ihr Computer keinen Internetzugang hat, bieten wir Ihnen eine alternative Aktivierungsmöglichkeit an (siehe unten
Aktivierung ohne Internetzugang).

 

Laden Sie AKVIS ArtWork herunter und installieren Sie das Programm. Bevor Sie mit der Installation beginnen, lesen Sie die
Installationsanleitung.

Jedes Mal, wenn Sie eine unregistrierte Version starten, wird das Anfangsfenster angezeigt. Hier finden Sie allgemeine
Informationen über die Version des Programms und die Anzahl der restlichen Tage bis zum Ablauf der Testzeit.

Außerdem können Sie das Fenster Über das Programm öffnen, indem Sie auf die Schaltfläche   in der Optionsleiste des

Programms klicken.

 

Klicken Sie auf TESTEN, um die Software zu evaluieren. Ein neues Fenster mit Lizenz-Varianten zum Testen wird angezeigt.

Sie können das Programm ohne Anmeldung und Registrierung während der Testperiode ausprobieren (10 Tage nach dem ersten
Start).

Während der Testperiode können Sie alle Optionen testen und entscheiden, welcher Lizenztyp Ihren Bedürfnissen am besten
entspricht. Wählen Sie eine der angebotenen Lizenztypen: Home (Plugin oder Standalone), Home Deluxe, oder Business.
Die Funktionalität des Programms hängt von einem Lizenztyp ab. Für eine detailliertere Übersicht konsultieren Sie bitte die
Vergleichstabelle.

 

Klicken Sie auf KAUFEN, um eine Lizenz zu bestellen.

Sobald die Zahlung erfolgt ist, erhalten Sie Ihre persönliche Seriennummer an Ihre E-mail-Adresse innerhalb weniger Minuten.

 

Klicken Sie auf AKTIVIEREN, um den Aktivierungsvorgang zu starten.
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Geben Sie Ihren Namen ein (das Programm wird auf diesen Namen registriert).

Geben Sie Ihre Seriennummer (Ihren Lizenzschlüssel) ein.

Wählen Sie eine Aktivierungsmethode — entweder direkte Verbindung zum Aktivierungsserver oder per E-Mail.

Direkte Verbindung zum Aktivierungsserver:

Es ist die einfachste Möglichkeit der Aktivierung.

Bei dieser Aktivierungsmethode muss Ihr Computer mit dem Internet verbunden sein.

Drücken Sie auf AKTIVIEREN.

Die Aktivierung ist nun abgeschlossen!

Aktivierungsanfrage per E-Mail senden:

Falls Sie die Aktivierung per E-Mail ausgewählt haben, erstellt das Programm eine Nachricht mit allen notwendigen
Informationen.

HINWEIS: Sie können diese Methode auch bei der Aktivierung ohne Internetzugang nutzen.

Wenn Ihr Computer nicht mit dem Internet verbunden sind, übertragen Sie die Aktivierungsanfrage auf einen anderen
Computer mit Internetzugang, z.B. per USB-Stick. Senden Sie uns diese Anfrage an: activate@akvis.com.

Bitte senden Sie keine Screenshots! Man muss den Text einfach kopieren und speichern.

Wir brauchen Ihre Seriennummer für die Software, Ihren Namen und Hardware ID (HWID) Ihres Computers.

Eine Lizenzdatei (ArtWork.lic) wird erstellt und Ihnen per E-Mail übersendet.

Speichern Sie die erhaltene .lic-Datei auf einen USB Stick und verlegen sie auf den Computer, auf welchem Sie das
Programm aktivieren möchten. Öffnen Sie die Datei nicht! Legen Sie die Lizenzdatei im AKVIS-Ordner ab:

Windows:

C:\Users\Public\Documents\AKVIS

(Dieser PC > Lokale Festplatte (C:) > Benutzer > Öffentlich > Dokumente > AKVIS)

Mac:

/Users/Shared/AKVIS

Öffnen Sie den  Finder, wählen Sie das Menü  Gehe zu, wählen Sie dann  Gehe zum Ordner...
(⌘ +Shift+G ), geben Sie "/Users/Shared/AKVIS" ein und klicken Sie auf Öffnen.

Linux:

/var/lib/AKVIS

Die Aktivierung ist nun abgeschlossen!
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Nach der Aktivierung wird die Schaltfläche KAUFEN durch die Schaltfläche UPGRADE ersetzt. Mithilfe dieses Buttons können
Sie Ihre Lizenz verbessern (beispielsweise Home-Lizenz auf Home Deluxe oder Business upgraden).

 

AKVIS ArtWork

20



ARBEITSBEREICH

AKVIS ArtWork steht in zwei Versionen zur Verfügung: als eigenständiges Programm und als Zusatzprogramm.

Standalone ist ein eigenständiges Programm. Sie können es wie gewohnt ausführen, indem Sie auf das Symbol des
Programms doppelklicken.

Plugin ist ein Zusatzmodul zur Integration in ein Bildbearbeitungsprogramm, z.B. in Photoshop.

Um das Plugin aufzurufen, wählen Sie es im Filter-Menü Ihres Bildbearbeitungsprogramms.

Der Arbeitsbereich von AKVIS ArtWork sieht wie folgt aus:

Arbeitsbereich von AKVIS ArtWork

Das Bildfenster mit den Registern Original und Ergebnis nimmt den größeren Teil des Programmfensters ein. Das Originalbild
wird im Original-Fenster gezeigt, das bearbeitete Bild wird im Ergebnis-Fenster gezeigt. Um das Originalbild und das Ergebnis
zu vergleichen, können Sie einfach auf das Foto im Ergebnis-Fenster klicken.

Die Optionsleiste kann mit einem Klick auf die kleine Dreieck-Taste ein- bzw. ausgeblendet werden. Um das minimierte Panel
anzuzeigen, ziehen Sie mit dem Cursor darüber. Wenn Sie bevorzugen, dass die Optionsleiste immer angezeigt bleibt, aktivieren
Sie das Kästchen Optionsleiste fixieren in den Optionen des Programms.

Die Schaltfläche   öffnet die Webseite von AKVIS ArtWork.

Mit der Schaltfläche   (nur in der Standalone-Version) öffnet man ein Bild zur Bearbeitung.

Mit der Schaltfläche   (nur in der Standalone-Version) speichert man das bearbeitete Bild.

Mit der Schaltfläche   (nur in der Standalone-Version) kann man das bearbeitete Bild drucken.

Mit der Schaltfläche   kann man die Liste der Presets laden (aus der .artwork-Datei).

Mit der Schaltfläche   kann man Presets exportieren (User-Voreinstellungen für die Bildbearbeitung). Die

Voreinstellungen werden in eine separate Datei mit der Endung .artwork gespeichert.
Die Schaltfläche   lädt die gespeicherten Leitlinien aus der Datei.

Die Schaltfläche   speichert die Leitlinien in eine Datei mit der Endung .direction.

Mit der Schaltfläche   /  kann man die Leitlinien anzeigen/ausblenden.

Die Schaltfläche   löscht die zuletzt gezogene Linie. Der Hotkey ist Strg+Z  auf Windows, ⌘ +Z  auf Mac.

Die Schaltfläche   stellt die zuletzt gezogene Linie wiederher. Der Hotkey ist Strg+Y  auf Windows, ⌘ +Y  auf Mac.

Die Schaltfläche   (nur in der Standalone-Version) öffnet das Dialogfenster Stapelverarbeitung. Mit dieser Funktion

können Sie einen ganzen Ordner mit Fotos automatisch mit den gewählten Einstellungen bzw. einem Preset bearbeiten
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lassen.
Mit der Schaltfläche   wird die Bildbearbeitung mit den aktuellen Einstellungen gestartet.

Mit der Schaltfläche   (nur in der Plugin-Version) wird das Ergebnis ans Bild angewendet und das Plugin wird

geschlossen.
Die Schaltfläche   ruft Informationen über das Programm auf.

Die Schaltfläche   ruft die Hilfe-Dateien auf.

Die Schaltfläche   ruft das Dialogfenster Optionen auf.

Die Schaltfläche   öffnet ein Fenster mit den neuesten Nachrichten über ArtWork.

 

Auf der linken Seite des Bildfensters gibt es eine Werkzeugpalette mit den folgenden Werkzeugen.

Mit der Schaltfläche   kann man das Vorschaufenster einblenden/ausblenden (mehr dazu).

Die Schaltfläche   aktiviert das Werkzeug Richtung der Pinselstriche, mit dem man Leitlinien im Ölgemälde-Effekt

und Pastell zeichnen kann.
Die Schaltfläche   aktiviert den Radiergummi, um Leitlinien ganz oder nur teilweise zu löschen.

Nachbearbeitungswerkzeuge (aktiv in dem Ergebnis-Register, nur für Home Deluxe/Business):

Die Schaltfläche   aktiviert das Wischfinger-Werkzeug, mit dem Sie kleine Unvollkommenheiten manuell beseitigen

können (aktiv in den Stilen Ölgemälde, Aquarell, Gouache und Pastell).
Die Schaltfläche   aktiviert das Weichzeichnen-Werkzeug, der den Kontrast zwischen den Pixeln verringert (nur in

den Stilen Aquarell und Gouache).
Die Schaltfläche   aktiviert den Farbpinsel (in den Stilen Linolschnitt, Schablonenkunst und Tintenzeichnung).

Das Werkzeug wird verwendet, um Striche mit der ausgewählten Farbe zu ziehen.
Die Schaltfläche   aktiviert den Protokollpinsel, der die Bildbereiche in ihren ursprünglichen Zustand teilweise oder

vollständig wiederherstellt.

Zusätzliche Werkzeuge:

Die Schaltfläche   aktiviert das Verschieben-Werkzeug. Es wird verwendet, um den angezeigten Bereich des Bildes

im Fenster zu verschieben, wenn das ganze Bild nicht in das Fenster passt. Um das Bild zu scrollen, klicken Sie auf diese
Schaltfläche, bringen Sie den Cursor auf das Bild und verschieben Sie es bei gedrückter Maustaste.
Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung der Programmfenstergröße angepasst.

Die Schaltfläche   aktiviert das Zoom-Werkzeug. Es ändert den Maßstab des Bildes. Um den Maßstab zu erhöhen,

drücken Sie auf die Schaltfläche und klicken Sie das Bild im Arbeitsbereich an. Um den Maßstab zu verringern, klicken
Sie auf das Bild bei gedrückter Alt -Taste.

Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung in ihrer Originalgröße (100%) dargestellt.

 

Das vorläufige Ergebnis wird automatisch im Vorschaufenster im Original-Register angezeigt. Im Navigator-Fenster kann
man das Bild skalieren. Der rote Rahmen zeigt den Bereich des Bildes, der im Bildfenster angezeigt wird. Wenn Sie den roten
Rahmen über das Bild verschieben, ändert sich der sichtbare Bereich im Bildfenster. Um den roten Rahmen zu verschieben,
bringen Sie den Cursor in den Rahmen hinein und ziehen Sie den Rahmen bei gedrückter Maustaste.

Navigator-Fenster

Außerdem ist es möglich, das Bild im Bildfenster zu scrollen, indem Sie die Leertaste auf der Tastatur drücken und das Bild
mit der linken Maustaste ziehen. Benutzen Sie das Mausrad, um das Bild nach oben und nach unten zu verschieben; wenn die
Strg -Taste gedrückt wird, wird das Bild nach links oder nach rechts verschoben; wenn die  Alt -Taste gedrückt wird, kann
man das Bild skalieren. Mit einem Rechtsklick auf die Bildlaufleiste kann man das Menü Schnellnavigation öffnen.

Verwenden Sie den Schieberegler, um das Bild im Bildfenster zu skalieren. Wenn Sie den Schieberegler nach rechts bewegen,
wird der Bildmaßstab vergrößert. Wenn Sie ihn nach links verschieben, verringert sich der Bildmaßstab.
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Außerdem können Sie einen Wert ins Feld eingeben.

Auch mit den Tasten +  und Strg++  (⌘ ++  unter Mac) können Sie die Skalierung erhöhen und mit  -  und Strg+-  (⌘ +-

unter Mac) die Skalierung verringern.

 

Unter dem Navigator-Fenster befinden sich die Einstellungen und zwei Registerkarten: Bild und Gestaltung.

Auf der Registerkarte Bild kann man die Parameter der Effekte anpassen (Ölgemälde, Comic, Tintenzeichnung usw.).
Auf der Registerkarte Gestaltung kann man das Bild mit einem Text, einer Leinwand-Textur oder einem Rahmen
versehen.

Im Presets-Bereich kann man die aktuellen Einstellungen speichern, um sie später zu verwenden. Nach dem Start des
Programms werden die Einstellungen des zuletzt benutzten Presets verwendet.

Unter den Einstellungen werden die Hinweise für die Parameter und die Schaltflächen angezeigt, über welche Sie mit dem
Cursor gehen.
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SO VERWENDEN SIE DAS PROGRAMM

AKVIS ArtWork steht als eigenständige Anwendung (Standalone-Programm) und als Zusatzprogramm (Plugin) zur
Verfügung.

Bitte folgen Sie der Anweisung, um ein Foto in Ölgemälde/Comic umzuwandeln:

Schritt 1. Öffnen Sie ein Bild zur Bearbeitung.

- Wenn Sie mit der eigenständigen Version arbeiten:

Öffnen Sie das Dialogfenster Bild öffnen mit einem Doppelklick auf den leeren Arbeitsbereich des Programms oder
mit einem Klick auf die Schaltfläche   in der Optionsleiste. Sie können auch das gewünschte Bild einfach in

den Arbeitsbereich des Programms mit der Maus ziehen. Die eigenständige Version von  AKVIS ArtWork
unterstützt die folgenden Formate: BMP, JPEG, RAW, PNG, PSD und TIFF.

- Wenn Sie mit der Plugin-Version arbeiten:

Öffnen Sie ein Bild in Ihrem Bildbearbeitungsprogramm mit dem Befehl  Datei -> Öffnen oder  mit  der
Tastenkombination Strg+O  auf Window, ⌘ +O  auf Mac.

Rufen Sie das Plugin AKVIS ArtWork auf:

in AliveColors: Effekte -> AKVIS -> ArtWork;
in Adobe Photoshop: Filter -> AKVIS -> ArtWork;
in Corel PaintShop Pro: Effekte -> Plugins -> AKVIS -> ArtWork;
in Corel Photo-Paint: Effekte -> AKVIS -> ArtWork.

Arbeitsbereich von AKVIS ArtWork

Schritt 2. Wählen Sie eine Maltechnik aus dem Drop-down-Menü Stil in den Einstellungen aus.

Das Programm bietet die ganze Reihe Stile an: Ölgemälde, Aquarell, Gouache, Comic, Tintenzeichnung,
Linolschnitt, Schablonenkunst, Pastell und Pointillismus.

Schritt 3. Passen Sie die Parameter in der Registerkarte Bild an.

Das Ergebnis wird im Vorschaufenster im Register Originalbild angezeigt. Das Vorschaufenster übernimmt nur die
Einstellungen der Register Bild und Leinwand. Im Linolschnitt-Modus ist das Vorschaufenster deaktiviert, weil der
Algorithmus das ganze Bild bearbeiten muss, um das Ergebnis zu bekommen.

Das Vorschaufenster ist ein gepunkteter Rahmen (diese punktierte Linie wird oft "marschierende Ameisen" genannt).
Ziehen Sie den Rahmen in die gewünschte Position auf dem Bild. Dafür bringen Sie den Cursor in den Rahmen und
verschieben das Vorschaufenster bei gedrückter Maustaste. Die andere Methode ist einfach auf dem gewünschten
Bereich mit der linken Maustaste zu klicken. Das Vorschaufenster verschwindet nach dem Start der Bildbearbeitung
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Automatische Pinselstriche

 

Leitlinien

 

Richtung der Pinselstriche geändert

und erscheint wieder, wenn Sie aufs Original-Register wechseln (wenn die Schaltfläche   gedrückt ist).

Mit einem Linksklick auf das Bild kann man zeitweilig auf das Originalbild umschalten und das konvertierte Muster mit
dem Originalfoto vergleichen.

Die Größe des Vorschaufensters wird in Optionen festgelegt (die Schaltfläche  ).

Vorschaufenster

Schritt 4. Klicken Sie auf , um das Bild in ein Gemälde mit den neuen Einstellungen zu konvertieren. Wenn Sie die

Werte nicht angepasst haben, wird das Bild mit den Standardeinstellungen (AKVIS Default oder das zuletzt verwendete
Preset) bearbeitet.

Die Abbrechen-Taste unterbricht den Prozess.

Schritt 5. In  Home Deluxe und Business-Version von ArtWork gibt es ein Werkzeug, das die Richtung der
Pinselstriche festlegt. Dieses Werkzeug wird nur im Ölgemälde-Stil und Pastell verwendet.

Um die "Leitlinien" zu editieren, verwenden Sie die Schaltflächen   /  und die folgenden Werkzeuge:

Richtung der Pinselstriche . Das Werkzeug sieht wie ein Kreuz aus. Zeichnen Sie mit dem Kreuz über das

Bild, um die Leitlinien festzulegen, entlang welchen die Pinselstriche gezogen werden. Die Änderungen sind sofort
im Vorschaufenster sichtbar. Um das ganze Bild zu bearbeiten, klicken Sie auf die Schaltfläche  .

Die Leitlinien können in einer Datei mit der Endung  .direction gespeichert werden (der Button ), um nach

einer Unterbrechung das Bild weiter bearbeiten zu können. Wenn die Leitlinien geladen werden (der Button  ),

werden sie automatisch an die Bildgröße angepasst.

Radiergummi . Verwenden Sie dieses Werkzeug, um die Linien zu löschen. Die Größe des Werkzeugs kann

durch Rechtsklick auf das Bild angepasst werden.

Schritt 6. Benutzen Sie die Gestaltung-Optionen, um Ihr Bild mit einer Leinwand-Textur, einem Rahmen oder einem Text
zu versehen.

Hinweis: Die Reihenfolge der Anwendung von Leinwand/Rahmen/Text hängt von der Position der Registerkarten ab.
Ziehen Sie die Registerkarten, um die Reihenfolge zu ändern.
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Text und Leinwand angepasst

Schritt 7. Es ist möglich, die laufenden Einstellungen als Preset zu speichern, um sie später benutzen zu können. Dafür
tragen Sie einen Namen für das neue Preset ins Feld Presets und klicken Sie auf Speichern. Wenn Sie das Programm
starten, werden die Einstellungen dieses Presets benutzt. Falls Sie die Werte geändert haben und nun die
Standardwerte des Presets wiederherstellen wollen, klicken Sie auf den Knopf Zurücksetzen.

Um ein Preset zu löschen, wählen Sie es aus der Preset-Liste und klicken Sie auf Löschen.

Um das Bild mit der Einstellungen eines Presets zu bearbeiten, klicken Sie auf .

Schritt 8. Um dem Bild den letzten Schliff zu geben, können Sie die Nachbearbeitungswerkzeuge (nur für  Home
Deluxe/Business Lizenzen) benutzen:

- Wischfinger  (in Stilen Ölgemälde/Aquarell/Gouache/Pastell verfügbar);

- Weichzeichnen  (in Stilen Aquarell und Gouache verfügbar);

- Farbpinsel  (in Stilen Linolschnitt, Schablonenkunst und Tintenzeichnung verfügbar);

- Protokollpinsel  (in allen Stilen verfügbar).

Achtung! Diese Werkzeuge können nur im Ergebnis-Register verwendet werden.

Wenn Sie in die Registerkarte Original wechseln und die Bearbeitung mit einem Klick auf  neu starten, gehen

die Änderungen verloren!

Schritt 9. Die eigenständige Version von AKVIS ArtWork erlaubt das Drucken des Bildes.
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Das Ergebnis

Schritt 10. Speichern Sie das Bild.

- Wenn Sie mit der eigenständigen Version arbeiten:

Klicken Sie auf die Schaltfläche  , um das Dialogfeld Speichern unter zu öffnen. Geben Sie einen Namen ein,

wählen Sie ein Format (JPEG, TIFF, BMP, PSD oder PNG) und bestimmen Sie einen Zielordner.

- Wenn Sie mit der Plugin-Version arbeiten:

Klicken Sie auf , um das Ergebnis anzuwenden und das Plugin-Fenster zu schließen. Das Plugin wird

geschlossen und das bearbeitete Bild wird im Arbeitsbereich der Bildbearbeitungssoftware angezeigt.

Rufen Sie das Dialogfeld Speichern unter mit dem Befehl Datei -> Speichern unter auf. Geben Sie einen Namen
für die Datei ein, wählen Sie ein Format und einen Zielordner aus.
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AUF LEINWAND

AKVIS ArtWork kann nicht nur ein Foto in ein Ölgemälde/Aquarell konvertieren, sondern auch Malerei auf einer rauhen
Oberfläche (wie Leinen, Wellenpapier, Ziegelsteinwand, metallische oder keramische Deckung) nachahmen.

In der Registerkarte Gestaltung wechseln Sie auf den Reiter Leinwand und aktivieren Sie das Kästchen Textur anwenden.

Hinweis: Sie können die Reiter  Leinwand/Rahmen/Text ziehen, um die Reihenfolge der Anwendung von
Gestaltungseffekten zu ändern.

Registerkarte 'Leinwand'

Sie können eine Textur aus der  Bibliothek -> Oberfläche auswählen oder Ihr Muster  laden:  Bibliothek ->
Benutzerdefiniert….

Passen Sie die Parameter der Leinwand an.
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RAHMEN

Auf der Registerkarte Rahmen können Sie Ihr Kunstwerk mit einem Rahmen versehen, um es zu vollenden.

Standardmäßig sind die Parameter dieser Registerkarte deaktiviert. Um den Bildrand zu gestalten, aktivieren Sie das Kästchen
Rahmen hinzufügen.

Hinweis: Sie können die Reiter  Leinwand/Rahmen/Text ziehen, um die Reihenfolge der Anwendung von
Gestaltungseffekten zu ändern.

Registerkarte 'Rahmen'

 

In der Drop-down-Liste wählen Sie einen Rahmentyp aus:

Klassischer Rahmen

Muster

Striche

Vignette

Passepartout
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TEXT

Sie können Ihr Bild personalisieren, indem Sie eine Signatur, ein Logo oder ein Wasserzeichen einfügen.

Auf der Registerkarte Gestaltung wechseln Sie auf den Reiter Text und aktivieren Sie einen der Modi - entweder Text oder
Bild.

Hinweis: Sie können die Reiter  Leinwand/Rahmen/Text ziehen, um die Reihenfolge der Anwendung von
Gestaltungseffekten zu ändern.

Registerkarte Text

Passen Sie die Parameter des Textes an.
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PRESETS BENUTZEN

AKVIS ArtWork enthält eine Reihe von einsatzbereiten Presets (Einstellungskombinationen), die Ihnen helfen sollen, mit der
Arbeit zu beginnen. Außerdem können Sie Ihre Lieblingseinstellungen als Preset speichern, um sie auch später benutzen zu
können. Wenn Sie den Cursor über ein Preset in der Dropdown-Liste bewegen, wird das entsprechende Muster im kleinen
Fenster auf der linken Seite der Liste angezeigt.

Sie können die Parameter eines Presets ändern, um das gewünschte Ergebnis zu erzielen.

Um das Bild mit einem Preset zu bearbeiten, wählen Sie es aus der Liste aus und drücken Sie auf  .

Jeder Effekt hat seine eigene Liste der Voreinstellungen. Jedes Preset beinhaltet die Einstellungen aller Registerkarten.

Um ein neues Preset zu erstellen, geben Sie einen Namen ein und drücken Sie auf Speichern.

Um die Standardeinstellungen wiederherzustellen, klicken Sie auf Zurücksetzen.

Um ein Preset zu löschen, wählen Sie es aus der Drop-down-Liste aus und klicken Sie auf Löschen.

Die eingebauten AKVIS Presets können nicht gelöscht werden.

Um ein Preset in eine Datei mit der Endung .artwork zu exportieren, klicken Sie auf . Um die Presets ins Programm zu

laden, klicken Sie auf .

Lesen Sie mehr über Import und Export von Presets.
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OPTIONEN

Die Schaltfläche   ruft das Dialogfenster Optionen auf. Es sieht so aus:

Sprache. Wählen Sie die gewünschte Sprache aus dem Menü aus.
Skalierung des Interfaces. Wählen Sie die Größe von Schnittstellenelementen. Wenn die Auto-Option ausgewählt
wird, erfolgt eine automatische Skalierung des Interfaces auf Basis der Bildschirmauflösung.
Farbe des Interfaces. Wählen Sie den gewünschten Stil der Programmschnittstelle: Hell oder Dunkel.
Skalierung des Bildes. Dieser Parameter definiert, wie das Bild im Bildfenster nach dem Öffnen skaliert wird. Es gibt
zwei Möglichkeiten:

- Ans Fenster anpassen. Das Bild wird so skaliert, dass es vollständig ins Bildfenster passt;

- Bei der Option 100% wird das Bild nicht skaliert. Beim Maßstab = 100% wird nur ein Teil des Bildes sichtbar.

Größe des Vorschaufensters. Wählen Sie den gewünschten Wert des Parameters. Die Größe des Vorschaufensters
kann Werte zwischen 400х400 Px und 2400х2400 Px annehmen.
Maximale Bearbeitungsgröße. Die Bildbearbeitung kann viel Zeit in Anspruch nehmen. Der Parameter ermöglicht die
Beschleunigung der Bildverarbeitung durch zeitweilige Verringerung der Bildgröße. Wenn die Dateigröße (in Megapixeln)
nicht den definierten Wert überschreitet, wird das Bild auf die übliche Weise bearbeitet. Wenn die geladene Datei größer
ist, wird das Programm die Bildgröße verringern, bearbeiten und dann wieder auf die ursprüngliche Größe zurücksetzen.
Zuletzt verwendete Dateien (nur in der Standalone-Version). Legen Sie die Zahl der zuletzt geöffneten Dateien fest,
die mit einem Rechtsklick auf  angezeigt werden. Maximum: 30 Dateien.

Hinweise anzeigen. Wenn Sie über die Parameter oder Schaltflächen mit der Maus gehen, wird im Feld Hinweise eine
kurze Beschreibung des jeweiligen Elements angezeigt. Sie können bestimmen, wo die Hinweise erscheinen:

- Unter den Einstellungen. Die Hinweise werden im rechten Teil des Hauptfensters unter den Parametern
angezeigt.

- Unter dem Bildfenster. Die Hinweise werden im Hauptfenster unter dem Bild angezeigt. Es ist zu empfehlen,
wenn es nicht genug Platz unter den Einstellungen gibt.

- Ausblenden. Wenn Sie mit dem Programm schon vertraut sind, können Sie die Hinweise ausblenden.

Animierte Bearbeitung. Wenn diese Option aktiv ist, können Sie die Umwandlung des Fotos in Echtzeit beobachten.
Es macht den Prozess unterhaltsam, nimmt doch mehr Zeit in Anspruch. Sie können diese Option deaktivieren, um die
Bearbeitungsgeschwindigkeit zu steigern. In diesem Fall wird das Ergebnis erst nach der abgeschlossenen Bearbeitung
gezeigt.
Kästchen Optionsleiste fixieren. Wenn das Kästchen ausgewählt ist, wird die Optionsleiste immer angezeigt. Wählen
Sie diese Funktion ab, um das Bedienfeld zu entsperren. Um es zu verstecken bzw. anzuzeigen, klicken Sie auf die kleine
Dreieckschaltfläche. Um das minimierte Panel anzuzeigen, ziehen Sie mit dem Cursor darüber.

Um diese Optionen zu speichern, klicken Sie auf OK.

Klicken Sie auf Standard wiederherstellen, um auf die Standardeinstellungen zurückzusetzen.
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STAPELVERARBEITUNG

AKVIS ArtWork unterstützt Stapelverarbeitung. Diese Technik gibt Ihnen die Möglichkeit, die gleichen Einstellungen auf
einen Ordner voller Fotos anzuwenden und sich damit viel Zeit zu sparen.

Man braucht nur einmal die Einstellungen anzupassen und danach wird das Programm den ganzen Stapel der Fotos
automatisch bearbeiten.

 

Auch wenn Sie noch nie zuvor diese Funktion verwendet haben, können Sie sich doch schnell zurechtfinden!

Wenn Sie die Standalone-Version von AKVIS ArtWork benutzen, lesen Sie diese Anleitung.

Wenn Sie ArtWork Plugin in Photoshop benutzen, folgen Sie den Schritten.

Mit der Stapelverarbeitung-Funktion in Photoshop können Sie zusätzlich zur Fotokorrektur, zum Beispiel, alle Fotos in die
gleiche Größe bringen.
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STAPELVERARBEITUNG MIT PHOTOSHOP PLUGINS

Die Plugins von AKVIS unterstützen die Automatisieren-Funktion in Adobe Photoshop.

Stapelverarbeitung ist sehr nützlich und zeitsparend, wenn Sie eine Reihe von Fotos bearbeiten möchten. Diese Funktion
wendet die gleichen Einstellungen von AKVIS OilPaint auf einen Ordner mit Bildern an.

Selbst wenn Sie Stapelverarbeitung bisher noch nie benutzt haben, wird es Ihnen keine Mühe kosten, sich damit
zurechtzufinden. Man muss eine Aktion anlegen und anschließend die Aktion auf das Verzeichnis anwenden, in dem sich die
Bilder befinden.

Folgen Sie der Anleitung:

Schritt 1. Erstellen Sie auf Ihrer Festplatte 2 Verzeichnisse: "Ausgangsdateien" und "Ergebnisdateien". Kopieren Sie Ihre
Fotos zur Bearbeitung in den Ordner "Ausgangsdateien". Bearbeitete Fotos werden in dem Ordner "Ergebnisdateien"
gespeichert.
Schritt 2. Öffnen Sie eines der Originalfotos in  Adobe Photoshop. Wir werden dieses Foto benutzen, um die
Einstellungen von AKVIS OilPaint anzupassen und eine Aktion zu erstellen.

Schritt 3. In der Aktionen-Palette klicken Sie auf die Schaltfläche Neuen Satz erstellen. In dem erscheinenden
Fenster geben Sie einen Namen für das neue Set von Aktionen ein, z.B. "AKVIS".

Wenn Sie bereits ein Set für AKVIS Aktionen haben, können Sie es einfach auswählen.

Neues Set in der Palette Aktionen anlegen

Schritt 4. Klicken Sie auf das Symbol Neue Aktion erstellen und geben Sie einen Namen für die Aktion ein, z.B. "Oil".
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Neue Aktion

Klicken Sie auf den Button Aufzeichnung beginnen, sodass die Aufnahme der Aktion startet.

Schritt 5. Rufen Sie das Plugin auf und passen Sie die Einstellungen an.
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Schritt 6. Klicken Sie auf . Das Plugin-Fenster wird geschlossen und der Effekt wird auf das Bild angewendet. In der

Aktionen-Palette wird eine neue Zeile mit dem Namen des Plugins angezeigt.

Schritt 7. Die Aktion wird immer noch aufgezeichnet. Wählen Sie im Menü Datei den Eintrag Speichern als undSchritt 7. Die Aktion wird immer noch aufgezeichnet. Wählen Sie im Menü Datei den Eintrag Speichern als und
speichern Sie das Bild im Verzeichnis "Ergebnisdateien" ab.
Schritt 8. Stoppen Sie die Aufnahme der Aktion, indem Sie den Button Ausführen/Aufzeichnen beenden drücken,
den Sie am Boden der Aktionen Palette finden.

Schritt 9. Löschen Sie die Datei, die Sie gleich im Verzeichnis "Ergebnisdateien" abgespeichert haben.
Schritt 10. Die Aktion ist angelegt und Sie können somit mit der Stapelverarbeitung der Videobilder fortfahren. Wählen
Sie unter Datei den Befehl Automatisieren -> Stapelverarbeitung.
Schritt 11. In dem Stapelverarbeitung-Fenster passen Sie die Einstellungen an:

Wählen Sie im Feld Satz "AKVIS" und die neue Aktion.

Im Feld Quelle legen Sie den Ordner  fest. Drücken Sie auf  Wählen... und wählen Sie den Ordner
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"Ausgangsdateien" aus.

Solange Sie noch nicht den Befehl ‚Datei öffnen’ in der Aktion ausgeführt haben, sollte das Kästchen "Dateien
nur speichern, wenn Aktionsset Befehl "Speichern" oder "Speichern unter" enthält" deaktiviert werden.

Wählen Sie für das Feld Ziel den Eintrag Ordner, drücken Sie anschließend Wählen... und wählen Sie den Ordner
"Ergebnisdateien" aus.

Aktivieren Sie das Kästchen "Dateien nur speichern, wenn Aktionsset Befehl "Speichern" oder "Speichern
unter" enthält".

Im Segment zur Dateibenennung geben Sie die Namenstruktur für die zu bearbeitenden Bilder an. Damit die
Bilder nicht umbenannt werden, wählen Sie Dokumentenname im ersten Feld und Erweiterung im zweiten Feld.

Schritt 12. Drücken Sie auf OK-Button, um die Stapelverarbeitung zu starten. Photoshop wendet das Plugin auf alle
Fotos in dem "Ausgangsdateien"-Ordner an und speichert die bearbeiteten Bilder in dem "Ergebnisdateien"-Ordner.
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DRUCKEN VON BILDERN IN AKVIS ARTWORK

Die eigenständige Version von AKVIS ArtWork erlaubt das Drucken des Bildes.
Klicken Sie auf die Schaltfläche  , um die Druckeinstellungen anzupassen.

Druckeinstellungen in AKVIS ArtWork

Passen Sie die Parameter in der Einstellungsleiste an:

Wählen Sie aus der Liste der verfügbaren Drucker den gewünschten Drucker aus. Legen Sie die Anzahl der zu
druckenden Kopien sowie die gewünschte Auflösung fest.

In der Parametergruppe Orientierung legen Sie die Orientierung des Bildes beim Drucken fest: Porträt (vertikal) oder
Album (horizontal).

Klicken Sie auf die Schaltfläche Seiteneinstellungen, um das Dialogfeld zu öffnen, in dem Sie die Seitengröße, die
Orientierung der Seite beim Drucken und die Breite der Kanten festlegen können.

Klicken Sie auf die Schaltfläche Ränder zurücksetzen, um die Standardeinstellungen wiederherzustellen.

Die Parameter Maßstab, Breite und Höhe und das Kästchen Auf Mediengröße skalieren legen die Druckgröße des
Bildes fest. Sie beeinflussen nicht das Bild selbst, sondern seine gedruckte Kopie. Es ist möglich, die Größe der
gedruckten Kopie zu ändern, indem man den Maßstab in Prozent festlegt (ein Wert unter 100% verringert das Bild, ein
Wert über 100% vergrößert es) oder indem man neue Werte für Breite und Höhe einträgt.

Um das Bild auf die ausgewählte Papiergröße zu skalieren, aktivieren Sie das Kästchen Auf Mediengröße skalieren.

Verschieben Sie das Bild mit der Maus oder mit den Pfeiltasten.

Sie können das zu druckende Bild mit einem Rahmen versehen. Die Breite und Farbe des Rahmens sind einstellbar.

Wählen Sie eine Hintergrundfarbe durch einen Klick auf das Farbmuster.

In dem Seite-Register können Sie mehrere Seiten auf ein Blatt Papier drucken lassen.
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Seite drucken

Kopien pro Blatt. Legen Sie fest, wie viele Kopien des Bildes auf ein Blatt Papier gedruckt werden.
Horizontal und Vertikal. Diese Parameter bestimmen, in wie vielen Spalten und Zeilen die Kopien des Bildes
dargestellt werden.
Abstand. Der Parameter stellt den Abstand zwischen den Kopien des Bildes ein.

In dem Poster-Register können Sie ein Bild auf mehrere Blätter verteilt ausdrucken und die Ausdrücke zu einem großen
Poster zusammenfügen.

Poster drucken

Blätter. Wenn das Kontrollkästchen aktiviert ist, können Sie die maximale Anzahl der Blätter festlegen, auf die das
Bild gedruckt wird. Das Bild wird so skaliert, dass es auf die gewünschte Anzahl Druckseiten passt. Wenn das
Kontrollkästchen deaktiviert ist, wird das Programm eine optimale Blattanzahl entsprechend der tatsächlichen
Bildgröße (Maßstab = 100%) automatisch auswählen.
Kleberänder. Aktivieren Sie dieses Kontrollkästchen, um die Breite der Kleberänder einzustellen. Die Ränder
werden rechts und unten gesetzt.
Schnittlinien. Aktivieren Sie dieses Kontrollkästchen, um die Schnittmarkierungen zu drucken. Sie helfen Ihnen
beim Zusammensetzen des Bildes.
Seitenzählung. Aktivieren Sie dieses Kontrollkästchen, um jedes Bildteil zu nummerieren. Nummer der Zeile und
Spalte wird am Rand gedruckt.
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Um den Druckprozess zu starten, klicken Sie auf die Schaltfläche Drucken. 
Um das Dialogfeld ohne Drucken des Bildes zu schließen, klicken Sie auf Abbrechen.

Klicken Sie auf die Schaltfläche  Eigenschaften..., um ein Systemdialogfeld zu öffnen, wo Sie erweiterte Einstellungen
anpassen und das Dokument drucken können.
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Vereinfachung = 1 Vereinfachung = 8

ÖLGEMÄLDE

Der Ölgemälde-Effekt wandelt Ihre Fotos in realistische Ölgemälde um. Ob ein Ölporträt oder eine Landschaftsmalerei, wird
das Programm Ihre Ideen erfolgreich umsetzen.

Ölgemälde

 

Auf der Registerkarte Bild kann man die Einstellungen anpassen, die die Umwandlung des Fotos in ein Ölgemälde festlegen.

Effekt-Parameter:

Vereinfachung (0-10). Der Parameter legt fest, inwieweit das Ölbild vereinfacht wird. Je höher der Wert des
Parameters, desto grober werden die Striche und desto weniger Details werden sichtbar. Bei hohen Werten des
Parameters hat das Bild mehr Ähnlichkeit mit einem Gemälde.

Krümmung der Striche (0-100). Der Parameter legt die Form der Striche fest - von geraden Linien (Wert = 0) zu
gebogenen Linien (Wert größer als 0). Die Komplexität und die Krümmung der Striche hängen von dem Wert des
Parameters ab.
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Krümmung der Striche = 10 Krümmung der Striche = 70

Max. Länge der Striche = 10 Max. Länge der Striche = 90

Breite der Striche = 5 Breite der Striche = 18

Intensität der Striche = 2 Intensität der Striche = 8

Max. Länge der Striche (1-100). Der Parameter legt die maximale Länge der Striche fest.

Breite der Striche (1-20). Die Breite der Striche.

Intensität der Striche (0-10). Je höher der Wert des Parameters, desto erkennbarer und deutlicher sind die Striche.

Dichte der Striche (1-100). Dieser Parameter erhöht die Anzahl der langen Striche und ändert ihre Position auf dem
Bild.
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Dichte der Striche = 20 Dichte der Striche = 85

Mikrodetail = 10 Mikrodetail = 85

Sättigung = 10 Sättigung = 65

Ohne Relief Relief = 50

Mikrodetail (0-100). Dieser Parameter verstärkt/reduziert die Deutlichkeit der feinen Striche.

Zusätzliche Effekte:

Sättigung (0-100). Der Parameter fügt dem Bild hellere Farben hinzu.

Relief (0-50). Dieser Parameter gibt den Strichen mehr Volumen. Das Ergebnis ist eine erhabene Oberfläche.

 

Zusätzliche Tools:

Auf der Original-Registerkarte:
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Richtung der Pinselstriche . Das Werkzeug verstärkt den Effekt eines handgemalten Ölbildes. Zeichnen Sie mit dem

Bleistift über das Bild, um die Leitlinien festzulegen, entlang welchen die Pinselstriche gezogen werden sollen. Auf diese
Weise stellen Sie sicher, dass die Pinselstriche der natürlichen Richtung folgen (z.B. die Stromlinien eines Flusses, runde
Früchte, Verwehungen, Haare usw.).

Auf der Ergebnis-Registerkarte:

Wischfinger . Mit diesem Werkzeug kann man auf einem bereits bearbeiteten Bild kleine Unvollkommenheiten manuell

beseitigen.

Protokollpinsel . Das Werkzeug erlaubt es, die Bildbereiche in ihren ursprünglichen Zustand teilweise oder

vollständig wiederherzustellen.

Achtung! Wenn Sie in die Registerkarte Original wechseln und die Verarbeitung mit einem Klick auf  erneut

ausführen, gehen die mit den Nachbearbeitungswerkzeugen vorgenommenen Änderungen verloren!

Hinweis: Die Werkzeuge sind nur für die Lizenzen Home Deluxe und Business vorhanden.
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Vereinfachung = 1 Vereinfachung = 7

AQUARELL

Ein Aquarell ist ein Malen mit wasserlöslichen Farben und gehört zu den ältesten Maltechniken. Die Farben werden auf
feuchtes Papier mit einem weichen Pinsel aufgetragen. Im Vergleich zum Ölgemälde entsteht dadurch kein Relief, dafür aber
ein weicher Übergang zwischen den Farben.

Ein klassisches Motiv für die Aquarellmalerei sind Landschaften, Blumen, Stilleben, Porträts.

Aquarell

 

Auf der Registerkarte Bild kann man die Einstellungen anpassen, die die Umwandlung des Fotos in ein Aquarell festlegen.

Parameter der Aquarellmalerei:

Vereinfachung (0-10). Der Parameter legt den Vereinfachungsgrad fest. Bei hohen Werten des Parameters werden die
Pinselstriche grober und die Detailgenauigkeit wird schwächer. Wenn das Aquarell mehr Ähnlichkeit mit dem
ursprünglichen Foto haben soll, verringern Sie den Wert des Parameters. Ein hoher Wert des Parameters verstärkt den
Wasserfarbeneffekt.

Sättigung  (0-100). Der Parameter beeinflusst die Intensität der Farben. Je höher der Wert des Parameters, desto
sauberer und heller werden die Farben.
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Sättigung = 30 Sättigung = 90

Tonvarianz = 20 Tonvarianz = 90

Intensität der Striche = 10 Intensität der Striche = 85

Weichzeichnen = 0 Weichzeichnen = 90

Tonvarianz (1-100). Dieser Parameter beeinflusst die Striche in den Gradienten. Wenn ein Bild große eintönige Flächen
enthält, können Sie mit diesem Parameter mehr Tonabwechslung erreichen.

Intensität der Striche (0-100). Der Parameter beeinflusst die Intensität der Striche. Bei höheren Werten wirken die
Striche stärker. Je niedriger der Wert, desto mehr ähnelt das Bild einem Aquarell.

Weichzeichnen (0-100). Dieser Parameter verwischt die Kanten der Pinselstriche.

Lasieren (0-100). Der Parameter fügt einer einheitlich bemalten Fläche klare Striche hinzu. Je höher der Wert des
Parameters, desto stärker ist die Veränderung der grundlegenden Farbtöne. In der Aquarellmalerei ist diese Technik als
Lasierung bekannt und wird verwendet, um schöne tiefere Farben zu erstellen.
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Lasieren = 0 Lasieren = 60

Ausfließen der Farben deaktiviert Ausfließen der Farben aktiviert

Ausfließen der Farben. Standardmäßig ist dieses Kästchen deaktiviert. Wenn es aktiviert wird, fließen die Farben aus
und die Grenzen der Objekte ändern sich. Wenn dies zu einer starken Verzerrung der Objekte führt, deaktivieren Sie
diese Option.

 

Zusätzliche Tools:

Um dem Ergebnis den letzten Schliff zu geben, verwenden Sie die Nachbearbeitungswerkzeuge: ,  und .

Hinweis: sie sind nur in der Registerkarte Ergebnis aktiv und stehen nur für die Lizenzen Home Deluxe und Business zur
Verfügung.

Mit dem Wischfinger  können Sie kleine Unvollkommenheiten manuell beseitigen.

Mit dem Weichzeichnen-Werkzeug  können Sie den Kontrast zwischen Pixeln verringern und die Pinselstriche

weicher machen.

Der Protokollpinsel  wiederherstellt die Bildbereiche in ihren ursprünglichen Zustand teilweise oder vollständig.

Achtung! Wenn Sie in die Registerkarte Original wechseln und die Bearbeitung mit einem Klick auf  neu starten,

geht das Ergebnis der Nachbearbeitung verloren!
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Dichte = 20 Dichte = 100

GOUACHE

Mit dem Gouache-Effekt können Sie ein Foto in ein Gouache-Bild umwandeln.

Gouache ist eine sehr vielseitige Maltechnik, die dichte intensive Farben verwendet. Die Gouache-Pinselstriche sind deutlich
sichtbar und die Farben sind fast deckend: es ist möglich, helle Farben mit dunklen Farben zu überdecken und umgekehrt. Die
Farben zeichnen sich durch Brillanz und Deckkraft aus. Dank der hohen Deckkraft können Sie außergewöhnliche Effekte
erzielen, die mit Aquarellfarben nicht erreichbar sind. Diese Technik ist in der Dekorationsmalerei und bei der Erstellung von
Farbskizzen und Zeichnungen weit verbreitet.

Gouache-Bild aus Foto

 

Auf der Registerkarte Bild kann man die Einstellungen anpassen, die die Umwandlung des Fotos in ein Gouache-Bild festlegen.

Primäre Pinselstriche:

Dichte (0-200). Dieser Parameter bezieht sich auf die ungefähre Anzahl der Pinselstriche im Bild.

Min/Max Länge der Striche (1-1000). Der Parameter bestimmt den Wertbereich der Strichlänge. Die Länge der Striche
wird anhand zwei Schieberegler festgelegt: der linke Regler zeigt die minimale Länge, während der rechte Schieberegler
die maximale Länge steuert. Die Striche auf dem Bild werden in diesem Wertbereich liegen - nicht kürzer als der minimale
Wert und nicht länger als der maximale Wert.
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Min/Max Länge der Striche = 1/50 Min/Max Länge der Striche = 50/500

Breite der Striche = 5 Breite der Striche = 85

Dichte = 20 Dichte = 70

Min/Max Länge der Striche = 1/30 Min/Max Länge der Striche = 50/180

Breite der Striche (1-100). Der Parameter beeinflusst die Breite der Striche.

 

Zusätzliche Pinselstriche:

Dichte (0-100). Dieser Parameter bezieht sich auf die ungefähre Anzahl der Pinselstriche im Bild. Bei höheren Werten
übermalen die Pinselstriche das Bild präziser. Je höher der Wert, desto weniger freie Flächen sind sichtbar.

Min/Max Länge der Striche (1-200). Der Parameter bestimmt den Wertbereich der Strichlänge.

AKVIS ArtWork

49



Breite der Striche = 2 Breite der Striche = 15

Unschärfe = 35 Unschärfe = 90

Abweichung = 0 Abweichung = 80

Breite der Striche (1-20). Der Parameter beeinflusst die Breite der Striche.

 

Effekt-Parameter:

Unschärfe (0-100). Dieser Parameter macht die Kanten der Pinselstriche unschärfer, gleicht Unebenheiten aus und
erzeugt die Illusion einer dicken Farbschicht.

Abweichung (0-100). Dieser Parameter legt die Abweichung der Pinselstriche von der Standardrichtung fest. Ist der
Wert auf 0 eingestellt, werden die Pinselstriche entlang der Kanten und Konturen des Originalbildes gezeichnet. Je höher
der Wert wird, desto zufälliger wird die Richtung der Pinselstriche.
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Zusätzliche Tools:

Um dem Ergebnis den letzten Schliff zu geben, verwenden Sie die Nachbearbeitungswerkzeuge: ,  und .

Hinweis: sie sind nur in der Registerkarte Ergebnis aktiv und stehen nur für die Lizenzen Home Deluxe und Business zur
Verfügung.

Mit dem Wischfinger  können Sie kleine Unvollkommenheiten manuell beseitigen.

Mit dem Weichzeichnen-Werkzeug  können Sie den Kontrast zwischen Pixeln verringern und die Pinselstriche

weicher machen.

Der Protokollpinsel  wiederherstellt die Bildbereiche in ihren ursprünglichen Zustand teilweise oder vollständig.

Achtung! Wenn Sie in die Registerkarte Original wechseln und die Bearbeitung mit einem Klick auf  neu starten,

geht das Ergebnis der Nachbearbeitung verloren!
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Originalbild Ergebnis

Radius der Vereinfachung = 2 Radius der Vereinfachung = 18

COMIC

Der Comic-Stil erstellt ein Comic aus einem Foto. Ein ähnlicher Effekt kann mit der Rotoscoping-Methode erreicht werden, die
bei Zeichentrickfilmen verwendet wird (z.B. bei der Produktion des berühmten Films "A Scanner Darkly"). Bei dieser Methode
wird jedes Bild des Videos in Zeichnung abgebildet.

In diesem Effekt wird die Anzahl der Schattierungen auf Hauptfarben reduziert (Tontrennung), um das Bild als ein
Poster/Plakat aussehen zu lassen.

 

Die Parameter des Feldes Bild passen die Vereinfachung des Bildes und die Farben an.

Radius der Vereinfachung (0-20). Der Radius der Vereinfachung für jeden Punkt des Bildes. Der Parameter beeinflusst
die Größe der vereinfachten Bereiche. Je höher der Wert des Parameters, desto stärker ist die Vereinfachung.
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Glätten = 20 Glätten = 80

Tontrennung = 10 Tontrennung = 70

Übergang der Farbsegmente = 1 Übergang der Farbsegmente = 9

Glätten (0-100). Dieser Effekt glättet den Übergang zwischen ähnlichen Farben. Die Farben wirken homogener.

Tontrennung (0-100). Dieser Parameter legt ähnliche Pixel zusammen und reduziert dadurch die Anzahl der Farben. Je
höher der Wert des Parameters, desto weniger Töne werden verwendet, um eine Farbe darzustellen.

Übergang der Farbsegmente (0-10). Die Weichheit des Übergangs zwischen den Farbsegmenten nach der
Tontrennung. Je höher der Wert des Parameters, desto gleichmäßiger werden die Farbsegmente umgerissen. Bei
niedrigen Werten haben die Segmente eher unregelmäßige Grenzen.
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Kästchen Konturen aktiviert Kästchen Konturen deaktiviert

Detail = 30 Detail = 45

Sensitivität = 50 Sensitivität = 90

Das Kästchen Konturen fügt dem Bild schwarze Konturen hinzu und aktiviert die folgenden Parameter.

Detailstufe (1-100). Die Anzahl von kleinen Details und Strichen, die die Konturen bilden.

Sensitivität (0-100). Die Intensität der Konturen. Je höher der Wert, desto dichter und klarer sind die Kanten.
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Dichte = 20 Dichte = 90

Länge der Striche = 1 Länge der Striche = 7

Schärfe = 10 Schärfe = 90

Dichte (1-100). Die Breite der schwarzen Konturen. Der kleinste Wert ist ein Pixel. Mit der Erhöhung des Wertes werden
die Linien dicker.

Länge der Striche (0-8). Der Parameter legt die Länge und die Form der einzelnen Striche fest. Bei großen Werten des
Parameters gibt es mehr Linien und sie sind schärfer.

Schärfe (0-100). Die Schärfe der Linien. Je größer der Wert des Parameters, desto klarer und genauer sind die
Konturen. Bei niedrigen Werten des Parameters werden die Striche breiter und glätter.

 

Zusätzliche Tools:

Der Protokollpinsel  wiederherstellt die Bildbereiche in ihren ursprünglichen Zustand teilweise oder vollständig.

Hinweis: Das Werkzeug ist nur in der Registerkarte Ergebnis und nur für die Lizenzen  Home Deluxe und Business
vorhanden.

Achtung! Wenn Sie in die Registerkarte Original wechseln und die Bearbeitung mit einem Klick auf  neu starten,

geht das Ergebnis der Nachbearbeitung verloren!
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Originalbild Lila Tintenzeichnung

Detail = 25 Detail = 60

TINTENZEICHNUNG

Bei der Tintenzeichnung-Technik werden farbige Tinten mit einer Feder oder einem Kugelschreiber auf Papier aufgetragen. Da
eine Feder oder ein Kugelschreiber eine harte Kante hat, wird das Ergebnis anders aussehen, als wenn Sie mit einem weichen
Bleistift zeichen.

Auf der Registerkarte Bild kann man die Einstellungen anpassen, die die Umwandlung des Fotos in eine Tintenzeichnung
festlegen.

 

Parameter:

Detailstufe (1-100). Die Anzahl von kleinen Details und Strichen, die die Konturen bilden.

Sensitivität (0-100). Die Intensität der Konturen. Je höher der Wert, desto dichter und klarer sind die Kanten.
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Sensitivität = 35 Sensitivität = 65

Dichte = 20 Dichte = 90

Dichte (1-100). Die Breite der schwarzen Konturen. Der kleinste Wert ist ein Pixel. Mit der Erhöhung des Wertes werden die
Linien dicker.

Länge der Striche (0-8). Der Parameter legt die Länge und die Form der einzelnen Striche fest. Bei großen Werten de
Parameters gibt es mehr Linien und sie sind schärfer.
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Länge der Striche = 1 Länge der Striche = 7

Schärfe = 10 Schärfe = 90

Schärfe (0-100). Die Schärfe der Linien. Je größer der Wert des Parameters, desto klarer und genauer sind die Konturen. Bei
niedrigen Werten des Parameters werden die Striche breiter und glätter.

Die Farbe der Konturen wird auf der Palette Umrissfarbe angezeigt. Um eine andere Farbe zu wählen, klicken Sie auf das
Farbfeld und wählen Sie eine neue Farbe in dem Farbauswahldialog aus.

Die Farbe für den Hintergrund der Zeichnung wird auf der Palette Hintergrundfarbe angezeigt. Um eine andere Farbe zu
wählen, klicken Sie auf das Farbfeld und wählen Sie eine neue Farbe in dem Farbauswahldialog aus.

 

Nachbearbeitungswerkzeuge

Farbpinsel . Verwenden Sie dieses Werkzeug, um Striche mit der ausgewählten Farbe zu ziehen.

Protokollpinsel . Mit diesem Werkzeug können Sie den Effekt verblassen und das Bild in seinen ursprünglichen

Zustand versetzen.

Alle Werkzeuge werden für die manuelle Nachbearbeitung in der Ergebnis-Registerkarte benutzt. Sie sind nur für die Lizenzen
Home Deluxe und Business verfügbar.

Achtung! Wenn Sie die Bildverarbeitung erneut ausführen, gehen die mit den Nachbearbeitungswerkzeugen vorgenommenen
Änderungen verloren!
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Originalbild Linolschnitt

Tontrennung = 15 Tontrennung = 90

Detail = 20 Detail = 70

LINOLSCHNITT

Der Linolschnitt stellt eine graphische Technik dar, die dem Holzschnitt ähnlich ist. Bei dieser Technik wird in eine
Linoleumplatte ein Negativmuster geschnitten. Eines der Merkmale des Linolschnittes ist der hohe Kontrast zwischen Schwarz
und Weiß. Es ist auch möglich, andere zwei Farben zu wählen.

Dieser Effekt kann bei der Erstellung von Postern nützlich sein. So können auch Amateurkünstler oder Studenten ihre Poster
und Flyer schön gestalten, da das Drucken in zwei Farben gleichzeitig stylisch und erschwinglich ist.

 

Auf der Registerkarte Bild kann man die Einstellungen für den Effekt eines Linolschnittes festlegen.

Achtung! Im Linolschnitt-Modus ist das Vorschaufenster deaktiviert. Man muss die Schaltfläche   betätigen, um die

Einstellungen aufs Bild anzuwenden.

Einstellungen:

Tontrennung (10-100). Dieser Parameter legt ähnliche Pixel zusammen und reduziert dadurch die Anzahl der Töne.

Detailstufe (1-100). Die Detailgenauigkeit des Bildes: Je höher der Wert des Parameters, desto mehr Details sind
vorhanden und desto dunkler ist das Bild.
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Schärfe = 5 Schärfe = 75

Mehr Weiß = 5 Mehr Weiß = 40

Mehr Schwarz = 10 Mehr Schwarz = 90

Schärfe (1-100). Die Schärfe des Bildes: Je höher der Wert des Parameters, desto schärfer sind die einzelnen Striche,
während die gesamte Detailgenauigkeit unverändert bleibt. Verschwommene Bilder werden dadurch dunkler aussehen.

Mehr Weiß (0-50). Dieser Parameter legt die Anzahl der Sektoren fest, die mit Weiß gefüllt werden.

Mehr Schwarz (0-100). Dieser Parameter legt die Anzahl der Sektoren fest, die mit Schwarz gefüllt werden.

Umrissfarbe. Legen Sie die Farbe des "Schnittes" fest. Klicken Sie auf das Farbfeld, um eine Farbe in dem
Farbauswahldialog zu wählen.

Hintergrundfarbe. Die Farbe des Hintergrunds, wo das Muster "geschnitten" wird. Klicken Sie auf das Farbfeld, um eine
Farbe in dem Farbauswahldialog zu wählen.
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Nachbearbeitungswerkzeuge

Farbpinsel . Verwenden Sie dieses Werkzeug, um Striche mit der ausgewählten Farbe zu ziehen.

Protokollpinsel . Mit diesem Werkzeug können Sie den Effekt verblassen und das Bild in seinen ursprünglichen

Zustand versetzen.

Alle Werkzeuge werden für die manuelle Nachbearbeitung in der Ergebnis-Registerkarte benutzt. Sie sind nur für die Lizenzen
Home Deluxe und Business verfügbar.

Achtung! Wenn Sie die Bildverarbeitung erneut ausführen, gehen die mit den Nachbearbeitungswerkzeugen vorgenommenen
Änderungen verloren!
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Weichzeichnen = 1 Weichzeichnen = 25

SCHABLONENKUNST

Der Schablonenkunst-Stil in AKVIS ArtWork verwandelt ein Bild in eine Schablonenzeichnung mit kontrastreichen Konturen.

Die Schablonenkunst ist eine Street-Art-Technik zur Reproduktion von Designs, indem Tinte oder Farbe über in Pappe,
Kunststoff oder Metall geschnittene Löcher auf die zu dekorierende Oberfläche aufgetragen wird. Mit dem Programm können
Sie einen ausdrucksstarken einfarbigen Druck erstellen. Es ist auch möglich, Mitteltonbereiche hinzuzufügen und ein Schraffur-
oder Pop-Art-Muster anzuwenden.

Schablonenzeichnung

Auf der Registerkarte Bild lassen sich die Parameter zur Umwandlung eines Fotos in eine Schablonenzeichnung festlegen.

 

Effektparameter:

Weichzeichnen. Das vorläufige Weichzeichnen des Originalbildes. Der Parameter erlaubt es, das Bild zu vereinfachen
und überflüssige Details zu entfernen.

Glättung. Die Glättung der Bereichsgrenzen im Bild.
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Glättung = 0 Glättung = 50

Mehr dunkle Bereiche Mehr helle Bereiche

Weiß auf Grau Blau auf Schwarz

Schatten/Lichter. Der Parameter legt die Füllbereiche fest. Der linke Schieberegler steuert die Anzahl der mit dunkler
Farbe gefüllten Bereiche (im Bereich von Grau bis Schwarz), der rechte Schieberegler steuert die Anzahl der mit heller
Farbe gefüllten Bereiche (im Bereich von Weiß bis Grau).

Farbe/Hintergrund. Der Parameter legt die Farben fest. Die Hauptfarbe wird zum Zeichnen von Konturen und dunklen
Bereichen verwendet. Die Hintergrundfarbe wird für die hellen Bereiche verwendet. Um die Farbe zu ändern, klicken Sie
auf das Quadrat und wählen Sie im Standarddialog eine Farbe aus.

Verwenden Sie den Schieberegler Mitteltöne, um einen durchschnittlichen Farbton der Zwischenzone anzupassen
(standardmäßig ist Grau).

 

Wenden Sie zusätzliche Effekte an, indem Sie die Kontrollkästchen aktivieren: Konturen, Schraffur, Pop Art. Passen Sie ihre
Einstellungen in den Registerkarten unten an.

Hinweis: Sie können entweder Schraffur oder Pop Art verwenden, nicht aber beide gleichzeitig.
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Konturen deaktiviert Konturen aktiviert Schraffur aktiviert Pop Art aktiviert

Empfindlichkeit = 5 Empfindlichkeit = 100

Breite = 1 Breite = 70

Konturen. Aktivieren Sie das Kontrollkästchen, um dem Bild Konturen hinzuzufügen.

Empfindlichkeit. Die Anzahl der Konturlinien.

Breite. Die Intensität und Breite der Konturlinien.

Schraffur. Aktivieren Sie das Kontrollkästchen, um den Mitteltonbereichen eine Schraffur hinzuzufügen.

Abstand. Der Abstand zwischen den Linien und ihre Anzahl.
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Abstand = 25 Abstand = 100

Breite = 15 Breite = 85

Tontrennung = 5 Tontrennung = 100

Breite. Die Dicke der Linien.

Tontrennung. Die Anzahl der Bereiche mit unterschiedlicher Schraffur. Bei einem Wert von 100 ist die Schraffur
gleichmäßig.

Zufällige Neigung. Ein Generator, der eine zufällige Schraffurrichtung erzeugt.
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Zufällige Neigung = 863 Zufällige Neigung = 5178

Kreuzschraffur deaktiviert Kreuzschraffur aktiviert

Rhombus Dollar

Kreuzschraffur. Das Kontrollkästchen aktiviert den Schraffurmodus. Striche werden in verschiedene Richtungen
gezogen.

Pop Art. Aktivieren Sie das Kontrollkästchen, um die Mitteltonbereiche mit Musterelementen zu füllen (ein Retro-
Halbtoneffekt).

Muster. Die Dropdown-Liste bietet eine Liste von Elementen: Kreis, Quadrat, Rhombus, Dreieck, Kreuz, Dollar.

Versatz. Die untereinander liegenden Elemente werden um das halbe Intervalll verschoben.
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Versatz deaktiviert Versatz aktiviert

Intervall = 15 Intervall = 70

Größe = 5 Größe = 15

Intervall. Der Abstand zwischen den Elementen.

Größe. Die Größe der Elemente. Die Elemente können ineinander übergehen, um einen dichteren Schattierungseffekt zu
erzeugen.

 

Nachbearbeitungswerkzeuge:

Farbpinsel . Verwenden Sie dieses Werkzeug, um Striche mit der ausgewählten Farbe zu ziehen.

Protokollpinsel . Mit dem Werkzeug können Sie Teile eines Bildes in einen früheren Protokollzustand

zurückversetzen, indem Sie darüber malen.

Alle Tools sind darauf ausgelegt, das Bild auf der Ergebnis-Registerkarte manuell zu bearbeiten und sind nur für die Home
Deluxe- und Business-Lizenzen verfügbar.

Achtung! Wenn Sie die Bildbearbeitung erneut ausführen, gehen die mit den Nachbearbeitungswerkzeugen vorgenommenen
Änderungen verloren!
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Änderungen verloren!
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Breite der Striche = 1 Breite der Striche = 70

PASTELL

Das Pastell ist eine Maltechnik, die sozusagen die Lücke zwischen Malerei und Zeichnung überbrückt.

Pastell aus Foto

Attention! Der Stil Pastell ist nur bei den Lizenzen Home Deluxe und Business vorhanden.

Auf der Registerkarte Bild kann man die Einstellungen anpassen, die die Umwandlung eines Fotos in ein Pastellbild festlegen.

Effekt-Parameter:

Breite der Striche (0-100) beeinflußt die Breite der Striche.

Min/Max Länge der Striche (1-100). Der Parameter bestimmt den Wertbereich der Strichlänge. Die Länge der Striche
wird anhand zwei Schieberegler festgelegt: der linke Regler zeigt die minimale Länge, während der rechte Schieberegler
die maximale Länge steuert. Die Striche im Bild werden in diesem Wertbereich liegen - nicht kürzer als der minimale Wert
und nicht länger als der maximale Wert.

Auf diese Weise können Sie verschiedene Striche generieren - von kurzen und dünnen (als ob mit einem Bleistift
gezeichnet) bis hin zu breiten und langen Strichen.
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Min/Max Länge der Striche = 1/11 Min/Max Länge der Striche = 45/100

Intensität der Striche = 5 Intensität der Striche = 80

Dichte = 5 Dichte = 80

Intensität der Striche (0-100). Der Parameter wirkt sich auf die Sichtbarkeit der Striche aus. Bei niedrigen Werten sind
sie blass und weich. Bei höheren Werten gibt es mehr Farbpigment in jedem Strich, sodass die Striche dunkler und
größer werden.

Dichte (0-100). Der Parameter beeinflusst die Anzahl der Striche. Je höher der Wert, desto weniger ungefärbte
Bereiche verbleiben. Wenn alle Lücken ausgefüllt sind, werden mehrere Schichten übereinander gemalt, sodass ein
Lasureffekt entsteht.

Achtung: bei hohen Werten des Parameters verlängert sich die Bearbeitungszeit.

Aufhellung = 10 Aufhellung = 80

Aufhellung (0-100). Der Parameter beeinflusst die Anzahl von weißen Strichen. Je höher der Wert, desto mehr helle
Farbtöne werden benutzt.
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Glättung = 2 Glättung = 10

Glättung (1-10). Der Parameter beeinflusst die Struktur der Zeichnung, indem er die Striche verschmiert.

 

Zusätzliche Tools:

Auf der Original-Registerkarte:

Richtung der Pinselstriche . Das Werkzeug verstärkt den Effekt eines handgemalten Ölbildes. Zeichnen Sie mit dem

Bleistift über das Bild, um die Leitlinien festzulegen, entlang welchen die Pinselstriche gezogen werden sollen. Auf diese
Weise stellen Sie sicher, dass die Pinselstriche der natürlichen Richtung folgen (z.B. die Stromlinien eines Flusses, runde
Früchte, Verwehungen, Haare usw.).

Auf der Ergebnis-Registerkarte:

Wischfinger . Mit diesem Werkzeug kann man auf einem bereits bearbeiteten Bild kleine Unvollkommenheiten manuell

beseitigen.

Protokollpinsel . Das Werkzeug erlaubt es, die Bildbereiche in ihren ursprünglichen Zustand teilweise oder

vollständig wiederherzustellen.

Achtung! Wenn Sie in die Registerkarte Original wechseln und die Verarbeitung mit einem Klick auf  erneut

ausführen, gehen die mit den Nachbearbeitungswerkzeugen vorgenommenen Änderungen verloren!

Hinweis: Die Werkzeuge sind nur für die Lizenzen Home Deluxe und Business vorhanden.
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Punktgröße = 25

 
Punktgröße = 75

POINTILLISMUS-EFFEKT

Pointillismus ist eine Maltechnik, bei der Farbpunkte wie Mosaiksteinchen eng nebeneinander auf die Leinwand aufgetragen
werden. Diese Stilrichtung gilt als Weiterführung des Impressionismus, die Kunst des sinnlichen Eindrucks darstellte und der
modernen Kunst den Weg bereitete.

Achtung! Der Pointillismus-Stil ist nur bei den Lizenzen Home Deluxe und Business vorhanden.

Pointillismus-Effekt

Sie können die Parameter des Effekts in dem Bild-Register anpassen:

Größe der Punkte (10-100). Dieser Parameter legt die maximale Größe der Punkte fest.

Dichte (10-100). Der Parameter ändert die Anzahl der Punkte im Bild. Je höher der Wert, desto weniger Bereiche bleiben
unbemalt.
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Dichte = 20

 
Dichte = 70

 
Sättigung = 10

 
Sättigung = 50

 
Farbenvielfalt = 5

 
Farbenvielfalt = 25

Sättigung (0-100). Mit diesem Parameter variieren Sie die Farbintensität der Pinselstriche. Bei einem Wert von 0 wird die
Sättigung des ursprünglichen Bildes beibehalten. Bei einer Erhöhung des Parameters werden die Farben leuchtender und satter.

Farbenvielfalt (0-100). Bei einer Erhöhung des Wertes werden einige Punkte ihre Farbe ändern. Je höher der Wert ist, desto
mehr Farben erscheinen im Bild und desto gesättigter sind sie.

Relief (0-100). Dieser Parameter verleiht den Strichen Volumen. Bei niedrigen Werten sind die Punkte flach. Je höher der Wert,
desto ausgeprägter die Striche.
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Relief = 20

 
Relief = 90

 
Form = 10

 
Form = 90

Form (0-100). Dieser Parameter bestimmt die Form der Pinselstriche. Bei einem Wert von 0 haben die Striche eine runde
Form, bei einer Erhöhung des Parameters verwandeln sie sich in Ellipsen.

Zufallszahl (0-9999). Dies ist die Anfangsnummer für den Zufallszahlengenerator, der die Verteilung der Pinselstrichen
bestimmt. Jede Zahl erstellt eine einzigartige Verteilung von Farbflecken.

 

Zusätzliche Tools:

Der Protokollpinsel  wiederherstellt die Bildbereiche in ihren ursprünglichen Zustand teilweise oder vollständig.

Hinweis: Das Werkzeug ist nur in der Registerkarte Ergebnis und nur für die Lizenzen  Home Deluxe und Business
vorhanden.

Achtung! Wenn Sie in die Registerkarte Original wechseln und die Bearbeitung mit einem Klick auf  neu starten,

geht das Ergebnis der Nachbearbeitung verloren!
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EFFEKT DER HALBBEARBEITUNG

Um das Foto-zu-Zeichnung-Rendering unterhaltsamer zu machen und die Konvertierung in Echtzeit zu zeigen, bietet AKVIS
ArtWork eine animierte Verarbeitungsoption. Sie können verfolgen, wie weiße Stellen immer weniger werden, bis das
Ergebnisbild erscheint. Der Effekt kann sehr beeindrucken sein, sodass wir von euch oft die Frage gestellt bekommen: Ist es
möglich, das Foto-zu-Zeichnung-Rendering auf halbem Weg zu stoppen und das teilbearbeitete Bild zu speichern?

Es gibt einen kleinen Trick, um dies zu tun.

 

Schritt 1. Öffnen Sie ein Bild in AKVIS ArtWork.

Originalfoto

Schritt 2. Klicken sie auf den Button , um die Bearbeitung des ganzen Bildes zu starten (die Einstellungen spielen

keine Rolle – wir passen sie später noch an).

Achtung: In diesem Schritt ist es notwendig, den Bearbeitungsprozess zu Ende zu führen - sonst startet die
Bearbeitung neu, wenn Sie den Prozess stoppen.

Unser Bild wurde mit Standardeinstellungen (Preset AKVIS Default) bearbeitet. Das Gemälde ist zwar schön, aber auch
ziemlich langweilig.

Voreinstellung "AKVIS Default"

Schritt 3. Wechseln Sie auf die Original-Registerkarte und stellen Sie die Parameter nach Ihrem Geschmack ein oder
wählen Sie eines der Presets von AKVIS. Man muss mindestens ein Parameter ändern (auch nur von 0 auf 1).

Wir wählen das Preset AKVIS Long Strokes:
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Schritt 4. Starten Sie das Rendering neu durch einen Klick auf . Klicken Sie gleich auf den Button Abbrechen

neben dem Fortschrittsbalken.

Schritt 5. Es erscheint eine Frage, ob Sie die Bearbeitung unterbrechen wollen. Verfolgen Sie die animierte Bearbeitung
und wenn das gewünschte Ergebnis erreicht wird, klicken Sie auf Ja.

Schritt 6. Gehen Sie auf die Ergebnis-Registerkarte und voilà!
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Teilbearbeitetes Bild

Schritt 7. Wenn Ihnen das Ergebnis nicht gefällt, ändern Sie die Einstellungen (mindestens einen Parameter) und
wiederholen Sie den Vorgang: Starten->Abbrechen->Ja->Ergebnis.

Sie können ganz unterschiedliche Ergebnisse erhalten:
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Originalbild Ergebnis

SONNENUNTERGANG AM GARDASEE IN PASTELLTÖNEN

Der Gardasee ist einer der größten und schönsten Seen Italiens. Das Ufer des Gardasees ist ein idyllischer Ort: das
sonnenbegünstigte Tal mit milder Mittelmeerluft ist mit Olivenhainen bepflanzt und dahinter ragen die schneebedeckten Alpen
mächtig hervor.

In diesem Tutorial benutzen wir den Pastell-Stil in AKVIS ArtWork, um die ganze Schönheit dieses zauberhaften Fleckchens
Erde zur Geltung zu bringen.

 

Schritt 1. Öffnen Sie das Foto in AKVIS ArtWork und wählen Sie den Stil Pastell aus der Liste.

Gardasee

Schritt 2. Das Vorschaufenster zeigt einen Teil des Bildes, der mit laufenden Einstellungen bearbeitet wurde. Das
Vorschaufenster hilft Ihnen, die Parameter anzupassen und die Änderungen gleich zu verfolgen.

Schritt 3. Klicken Sie auf , um die Bearbeitung zu starten.
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Pastellmalerei aus Foto

Schritt 4. Die Pinselstriche folgen normalerweise den Konturen von Objekten. Mithilfe des Tools Richtung der
Pinselstriche  können Sie die Richtung der Pinselstriche ändern.

Um die Striche horizontal zu orientieren, gehen Sie zum Original-Fenster und ziehen Sie mit dem Werkzeug ein paar
Leitlinien.

Richtungsgebende Linien

Schritt 5. Klicken Sie auf , um das Bild in ein Gemälde mit den neuen Einstellungen zu konvertieren.
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Pastellbild 
(zum Vergrößern anklicken)
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MAGISCHES PFERD

Magische Pferde sind in den Märchen vieler Kulturen vertreten - Tulpar, Pegasus, Sivka-Burka, Bayard, Akbuzat, Sleipnir,
Aranzal, Târkshya, Babieca usw. Die Pferde der Götter, Ritter und Helden sind wunderschön und mit besonderen Gaben
ausgestattet.

In diesem Beispiel werden wir AKVIS ArtWork einsetzen, um ein Aquarellbild eines Pferdes zu erstellen und das Pferd in eine
geheimnisvolle Kreatur umzuwandeln.

 

Schritt 1. Öffnen Sie ein Bild mit AKVIS ArtWork und wählen Sie den Stil Aquarell aus der Liste.

Schritt 2. Das Vorschaufenster zeigt einen Teil des Bildes, der mit laufenden Einstellungen bearbeitet wurde. Das
Vorschaufenster hilft Ihnen, die Parameter anzupassen und die Änderungen gleich zu verfolgen.
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Vorschaufenster, Standardeinstellungen

Schritt 3. Klicken Sie auf , um die Bearbeitung zu starten.

Hinweis: Nach der Bearbeitung können Sie das Ergebnis mit Nachbearbeitungswerkzeugen Wischfinger  und

Weichzeichnen  manuell verfeinern (nur in den Lizenzen Home Deluxe und Business vorhanden).

Hier ist unser Aquarellbild:
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Scan von einem Farbnegativ Ergebnis

ARTWORK GALERIE

Andrey Terebov (Kiew) hat uns eine Email geschrieben, in der er seine Erfahrungen mit AKVIS ArtWork mitteilt. Im
Folgenden finden Sie Auszüge aus der Email und seine Kommentare zu den Bildern.

 

Andrey schreibt, dass er sich schon seit langem für die Fotokunst sowie für die Methoden der Bildbearbeitung und Stilisierung
interessiert. Er hat die Testversion von AKVIS ArtWork ausprobiert und konnte die Benutzerfreundlichkeit und die Qualität des
Ergebnisses schätzen.

Ich druckte ein Paar Fotos auf einem Plotter in 30х45 und 50х60-Format auf einem mit Leinen beschichteten Papier.
Echte Ölgemälde als Ergebnis! Das Drucken auf mattem Fotopapier liefert auch gute Ergebnisse. Wichtig ist eine
Texturschicht. Ein geeigneter Rahmen (ohne Glas) verleiht dem Ölbild den letzten Schliff.

Die klassische Fotografie hat bestimmte Regeln. In manchen Genres können diese Konventionen den Künstler etwas
einengen (Porträt, Landschaft, Stillleben usw.). Die weitere Bildbearbeitung erzielt nicht immer den gewünschten
Effekt. Mit AKVIS ArtWork hat man die Möglichkeit, seine kreativen Ideen zu verwirklichen. Das ist es nicht nur ein
Malprogramm, sondern ein ernstes kreatives Werkzeug.

Andrej wollte einige interessanten Anwendungsweisen von AKVIS ArtWork vorstellen:

In Ihren Fotoarchiven gibt es bestimmt wertvolle Abzüge, Negative, Dias usw., die aus verschiedenen Gründen
(Mängel, Schäden, Unschärfe usw.) eine Retusche oder Wiederherstellung brauchen. Man kann sie bestimmt
aufbessern, aber manchmal hilft es ein Programm anzuwenden, das auch aus solchem Bild ein Kunstwerk machen
kann. Die Anwendung von AKVIS Artwork in der Endphase der Bearbeitung wird dazu beitragen, Fehler zu verbergen
und ein einmaliges Kunstwerk zu erstellen.

Hinweis: Klicken Sie auf das Bild, um eine größere Version in einem Fenster aufzumachen.

Beispiel 1. Testbild. Nach dem Einsatz von AKVIS ArtWork hat das Foto eine künstlerische Wirkung.

Beispiel 2. Ausschnitt (etwa 25%) aus einem Farbnegativ mit Unschärfe und Verzeichnung. Die Versionen 1 und 2 sind gute
Beispiele für Kreativität: ArtWork kann kreative Ergebnisse sogar aus defekten Fotos erzeugen.
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Unbrauchbares, 
verdorbenes Photo

Version 1 Version 2

Scan eines Photonegatives Ergebnis

Digitalbild Ergebnis

Beispiel 3. Die Komplexität der Farben. AKVIS Artwork erzeugt ein erfreuliches Ergebnis.

Beispiel 4. Sorgfältige Auswahl der Pinselstriche gibt diesem Bild eines Touristen eine sehr künstlerische Wirkung.

Beispiel 5. Durch Verwackeln der Aufnahme war es unmöglich, einen großformatigen Druck dieses Bildes aus 24x30mm Film zu
erstellen. Nach der Anwendung von AKVIS Artwork wurde das Bild im Format von 50x60cm gedruckt – ein erstaunliches
Ergebnis!
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Landschaftsaufnahme Ergebnis

Digitalaufnahme Ergebnis

Scan eines Farbnegatives, 
mit Weichzeichner

Ergebnis

Beispiel 6. Es ist überhaupt kein Problem, eine Amateuraufnahme in ein künstlerisches Porträt umzuwandeln.

Beispiel 7. “Impressionismus” mit AKVIS ArtWork.

Beispiel 8. Nach der Bearbeitung in AKVIS ArtWork (Hintergrund Leinwand mit Textur-Einstellung, etwas 2cm Überlappung)
wurde das Bild auf echtes Leinen auf einem Plotter ausgedruckt. Ein zufälliges Testbild wurde zu einem wunderbaren
Geschenk.
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Scan eines Farbnegative Ergebnis

Scan eines Farbnegatives mit Weichzeichner Ergebnis

Scan eines Farbnegatives mit Weichzeichner Ergebnis

Beispiel 9. Wunderbare Miniatur – ein Geschenk aus der Ukraine.
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Ergebnis

 

AKVIS ArtWork

88

http://akvis.com/img/examples/artwork/examples/artwork/artwork-gallery/example9c-result.jpg


Standardeinstellungen Detail = 20

POSTER AUS FOTO: NOTFALLKUH

Haben Sie schon einmal auf einer Wiese ... eine rote Kuh gesehen? Nein, das ist weder ein Warnsignal noch eine Zielscheibe.

Im Jahr 2005 gab es in der Hauptstadt der Schweiz eine Diskussion über die Wahl eines zusätzlichen Emblems des
Internationalen Rotkreuzes. Verschiedene Länder boten ihre eigenen Symbole. Darunter gab es auch eine rote Kuh, als Symbol
eines friedlichen Tieres, das Milch und Leben spendet. Dieser Vorschlag wurde abgelehnt.

In diesem Tutorial werden wir ein Poster mit einer roten Kuh erstellen.

 

Es geht ganz einfach:

Schritt 1. Öffnen Sie das Foto in AKVIS ArtWork mit einem Klick auf .

Originalbild

Schritt 2. Wählen Sie den Stil Comic aus dem Menü Stil. Im Vorschaufenster wird ein Teil des Bildes angezeigt, das
mit den aktuellen Einstellungen bearbeitet wurde. Damit es keine schwarzen Linien auf dem Himmel erscheinen,
reduzieren wir den Wert des Parameters Detailstufe von 40 auf 20:

Schritt 3. Klicken Sie auf , um das Bild zu bearbeiten.
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ArtWork Arbeitsbereich

Schritt 4. Um eine erläuternde Überschrift hinzuzufügen, klicken Sie auf die Registerkarte Gestaltung. Wählen Sie die
Farbe Rot für den Text und Schwarz für den Umriss.

Poster aus Foto

Schritt 5. Speichern Sie das Bild mit einem Klick auf  und schließen Sie AKVIS ArtWork.
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TRICKFILM MIT EINER KATZE

Der Autor des Anwendungsbeispieles ist Robert Bates (Texas, USA).

Dieses Tutorial wurde von einem Beispiel inspiriert, bei dem ein Video in einen Trickfilm mit AKVIS Sketch konvertiert wurde.

AKVIS ArtWork kann die letzten Einstellungen ebenso speichern und es steht einem ArtWork-Trickfilm nichts mehr im Wege.
Diese Funktion passt hervorragend dazu, die Bilder zu bearbeiten, aus deren das Video zusammengesetzt wird. Ohne
Stapelverarbeitung wäre es sehr mühsam gewesen, jedes Frame einzeln zu behandeln. Diese Anleitung wir Ihnen zeigen, wie
man diese Aufgabe automatisieren kann, um ein Video in einen Trickfilm mit AKVIS ArtWork zu verwandeln.

Original Video Trickfilm

Schritt 1. Bevor wir das Video in VirtualDub bearbeiten können, müssen wir es in ein passendes Format konvertieren.
Wir können z.B. das kostenlose Programm  Any Video Converter verwenden, um den Film in eine AVI-Datei zu
konvertieren.
Schritt 2. Öffnen Sie die AVI-Datei in VirtualDub mit dem Befehl Datei -> Video-Datei öffnen. Sie werden Ihr Video
als getrennte Bilder im Arbeitsbereich von VirtualDub sehen.

Schritt 3. Um ArtWork verwenden zu können, müssen wir das Video als Einzelbilder speichern. Dafür rufen wir den
Befehl Datei -> Export -> Bildsequenz auf. Ein Dialogfenster wird geöffnet. Geben Sie den Dateinamen, Bild-Format
(standardmäßig JPEG) und die Anfangsnummer der Bildserie ein. Als nächstes wählen Sie ein Verzeichnis, um Ihre Bilder
zu speichern und klicken Sie OK. Das Video wird als Einzelbilder in den ausgewählten Ordner kopiert. Schließen Sie
VirtualDub.
Schritt 4. Erstellen Sie einen Ordner für die Originalbilder ("Tigger Vid") und den Zielordner ("Tigger Vid Output").
Kopieren Sie die mit VirtualDub getrennten Bilder in den Quelle-Ordner ("Tigger Vid").
Schritt 5. Die Funktion Stapelverarbeitung erlaubt die automatische Anwendung der gleichen Einstellungen auf eine
Reihe von Dateien.

Hinweis:

Mit ArtWork Standalone: Mit der Standalone-Version können Sie dafür das Dialog   verwenden.

Auf Photoshop mit ArtWork Plugin: Wenn Sie die Plugin-Version benutzen, müssen Sie eine Aktion anlegen und
anschließend die Aktion auf das Verzeichnis anwenden, in dem sich die Bilder befinden.
Eine Aktion kann mehr als einen Befehl umfassen, sodass Sie eine große Anzahl von Bildern in einem Arbeitsgang
abarbeiten können.
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Fangen Sie mit der Bearbeitung der Bilder in Adobe Photoshop an:

Öffnen Sie die Palette Aktionen: Fenster -> Aktionen (Alt+F9 ).

Jetzt legen wir fest, welche Aktionen an jedes einzelne Bild angewendet werden müssen. Klicken Sie auf Neue Aktion in
der Registerkarte Aktionen. Geben Sie einen Namen für die Aktion in das Dialogfeld ein (z.B. "Cartoon").

Öffnen Sie das erste Bild des Videos und klicken Sie auf die Schaltfläche Aufzeichnung beginnen (der rote Knopf,
zweiter von links). Wenn die Aufzeichnung begonnen wurde, wird jeder Photoshop-Befehl, den Sie geben, sofort
aufgezeichnet.

Palette Aktionen

Schritt 6. (fakultativ) Das Bild ist ziemlich unscharf. Dies kann mit AKVIS Enhancer korrigiert werden. Rufen Sie das
AKVIS Enhancer Plugin mit dem Befehl Filter -> AKVIS -> Enhancer auf.

Sie können die Einstellungen wie unten oder Ihre eigenen verwenden.  AKVIS Enhancer speichert die zuletzt

verwendeten Einstellungen, doch es wäre eine gute Idee, die Einstellungen als Preset zu speichern. Klicken Sie auf  ,

um das Ergebnis anzuwenden und das Plugin zu schließen.

AKVIS Enhancer Arbeitsbereich

Schritt 7. Zunächst wählen Sie das AKVIS ArtWork Plugin mit dem Befehl Filter -> AKVIS -> ArtWork. Sie sehen das
Bild im Arbeitsbereich des Plugins. Wählen Sie den Comic-Stil und die folgenden oder Ihre eigenen Einstellungen.

Klicken Sie auf  um das Bild zu bearbeiten und auf , um das Ergebnis zu akzeptieren. Das Bild wird wieder im

Arbeitsbereich von Photoshop angezeigt.
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AKVIS ArtWork Arbeitsbereich

Schritt 8. Wählen Sie Speichern unter aus dem Menü Datei und speichern Sie die Datei in den Ergebnisordner ("Tigger
Vid Output"). Klicken Sie auf Stop in der Registerkarte Aktionen. Löschen Sie die Datei, die Sie gerade in den
Ergebnisordner gespeichert haben.
Schritt 9. Öffnen Sie das Dialogfenster Stapelbearbeitung: Datei -> Automatisieren -> Stapelverarbeitung.

Wählen Sie die Einstellungen wie unten und klicken auf OK, um die Stapelverarbeitung zu starten. Der Prozess wird
einige Zeit dauern, abhängig von der Anzahl der Bilder und der Geschwindigkeit des Computers. Wenn der Prozess
abgeschlossen ist, öffnen Sie den Ergebnisordner ("Tigger Vid Output") und Sie werden die bearbeiteten Kopien der
Bilder sehen. Jetzt können wir daraus einen Trickfilm zusammensetzten.

Photoshop-Stapelverarbeitung

Schritt 10. Schließen Sie  Photoshop und öffnen Sie  VirtualDub. Wählen Sie Datei -> Video-Datei öffnen und
navigieren Sie zu den Ergebnisordner ("Tigger Vid Output"). Wählen Sie die erste Datei aus dem Drop-down-Menü neben
dem Dateityp: wählen Sie  Bildfolge. Klicken Sie auf Öffnen und VirtualDub wird aus den Bildern ein Video
zusammenstellen. Sie können dann die Vorschau des Films starten. In diesem Fall ist das Video zu langsam. Wir gehen zu
Video -> Frame rate und wählen Bildrate ändern (fps). Der ursprüngliche Wert war 25, so geben Sie ihn in das Feld
ein und klicken Sie auf OK.
Schritt 11. Wenn Sie das Audio von dem Original-Video verwenden wollen, wählen Sie Audio hinzufügen -> Audio aus
einer anderen Datei und klicken Sie auf die ursprüngliche Video-Datei. In unserem Fall war das Audio nicht so gut,
deshalb wählen wir einfach eine schöne Musik. Sie können auch einen Dialog oder Sound-Effekt hinzufügen.
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AM STADTKANAL

Als ich an einem schönen Sommertag den Stadtkanal entlang flanierte, hat mich der unüberwindliche Drang zum Malen
überwältigt. Ich hatte keine Farben und keine Staffelei mit, und, um ganz ehrlich zu sein, meine Landschaftsstudien haben nie
meine Zeichenlehrerin in der Schule überzeugt. Dafür hatte ich meine Kamera mit und machte ein Foto der Ansicht. Dann habe
ich mit dem Programm AKVIS ArtWork mein Foto in ein Ölgemälde umgewandelt. Herausgekommen ist eine Malerei, genau so
wie ich sie vor meinen Augen hatte.

 

Ich habe die Deluxe-Version von AKVIS ArtWork verwendet. Die Deluxe-Version (im Gegensatz zu Home-Lizenz) hat ein
Werkzeug namens Richtung der Pinselstriche. Dieses Tool kann Wunder tun. Sie können das Ergebnis mit und ohne diesen
Tool in voller Größe vergleichen: ein zip-Archiv mit drei Dateien 1st-result.jpg, 2nd-result.jpg und 2nd-result-with-canvas.jpg.

 

Folgen Sie der Anweisung:

Schritt 1. Öffnen Sie das Foto mit Ihrer Bildbearbeitungssoftware (wir verwenden die Plugin-Version des Programms).

Originalbild

Schritt 2. Rufen Sie das AKVIS ArtWork-Plugin auf. In AliveColors wählen Sie den Befehl  Effekte -> AKVIS ->
ArtWork im Menü aus, in Adobe Photoshop wählen Sie Filter -> AKVIS -> ArtWork, in Corel PaintShop Pro wählen
Sie Effects -> Plugins -> AKVIS -> ArtWork; und in Corel Photo-Paint benutzen Sie Effects -> AKVIS -> ArtWork.

Das Bild wird in den Arbeitsbereich geladen und, wenn es groß ist, auf das Fenster skaliert. Um eine visuelle Verzerrung
des Bildes zu vermeiden, wird es empfohlen, den Maßstab auf 100% zu setzen.
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Standardeinstellungen Vereinfachung = 6

Fragment des Bildes (skaliert auf 100%)

Schritt 3. Passen Sie die Parameter an. Das vorläufige Ergebnis wird automatisch im  Vorschaufenster angezeigt.
Ziehen Sie den Rahmen in die gewünschte Position auf dem Bild, um das entsprechende Fragment zu analysieren.

Ich möchte meine Landschaft in großen Strichen malen. Die meisten Maler streben nicht nach einer detaillierten
Wiedergabe der Realität. Ich erhöhe der Wert des Parameters  Vereinfachung. Dieser Parameter verringert die
Detaillierung des Bildes. Die Striche werden größer und das Bild sieht mehr als ein Gemälde aus. Die Vereinfachung = 6
ist hier durchaus sinnvoll.

Um das Bild heller zu machen, erhöhen wir den Wert der Sättigung bis 15.

Schritt 4. Klicken Sie auf , um das ganze Bild mit den neuen Einstellungen zu bearbeiten. Hier sehen Sie das

Ergebnis (1st result.jpg):
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Blätter (Fragment) Schiff (Fragment)

Schritt 5. Wir sind mit dem Ergebnis zufrieden. Aber wir können es noch realistischer machen, wenn wir das Werkzeug
Richtung der Pinselstriche  verwenden. Dieses Werkzeug gibt uns volle Kontrolle über das Resultat, weil es erlaubt,

die Richtung der Pinselstriche festzulegen. Wenn Sie sich das Bild 1st-result.jpg genau anschauen, stellen Sie fest, dass
das Schiff und die Bäume gut sind, aber das Wasser und der Himmel nicht perfekt aussehen. Der Grund dafür ist, dass
die Striche gleichmäßig gezogen werden, während ein Künstler für den Himmel horizontale Striche ziehen würde und für
den Fluss die Striche, die die Richtung des Stroms wiederholen:

Änderung der Richtung der Pinselstriche
Schritt 6. Klicken Sie auf . Das Ergebnis ist hier: 2nd-result.jpg. Sie können das Bild mit einem Leinwand und einer

Unterschrift versehen: 2nd-result-with-canvas.jpg).
Schritt 7. Klicken Sie auf , um die Änderungen anzuwenden und das Plugin AKVIS Artwork zu schließen. Ich habe

nur 4 Minuten gebraucht, um mein bescheidenes Kunstwerk zu erstellen. Ich habe es dann auf Papier gedruckt und im
Esszimmer an der Wand aufgehängt.
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Ölgemälde Ölgemälde auf Leinwand
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HARMONIE: ÖLPORTRÄT EINES MÄDCHENS

Das Programm AKVIS ArtWork imitiert verschiedene Maltechniken. In diesem Tutorial erstellen wir ein Ölporträt eines
Mädchens.

 

Folgen Sie der Anweisung:

Schritt 1. Öffnen Sie ein Bild in Ihrem Bildbearbeitungsprogramm mit dem Befehl Datei -> Öffnen.

Originalbild

Schritt 2. Rufen Sie das AKVIS ArtWork-Plugin auf. In AliveColors wählen Sie den Befehl  Effekte -> AKVIS ->
ArtWork im Menü aus, in Adobe Photoshop wählen Sie Filter -> AKVIS -> ArtWork; in Corel PaintShop Pro wählen
Sie Effects -> Plugins -> AKVIS -> ArtWork; und in Corel Photo-Paint benutzen Sie Effects -> AKVIS -> ArtWork.

Das vorläufige Ergebnis wird automatisch im  Vorschaufenster angezeigt. Das Programm verwendet dabei die
Einstellungen des Standard-Presets AKVIS Default oder des zuletzt verwendeten Presets. Die Standardeinstellungen
liefern meistens ein gutes Ergebnis, aber man kann sie auch weiter fein einstellen.

Schritt 3. Passen Sie die Parameters für die Striche an:

Vereinfachung = 3 (ein Wert höher als 3 kann die Streifen auf dem Pullover verwischen).

Um die Striche ausdrucksvoller zu machen, erhöhen wir deren Länge, Breite und Krümmung:

Krümmung der Striche = 71;
Max. Länge der Striche = 37;
Breite der Striche = 6.
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Standardeinstellungen Breite Striche

Um die Pinselstriche sichtbar zu machen, erhöhen Sie den Wert des Parameters Dichte der Striche. Wenn sich ein
Strich fehl am Platz befindet (zum Beispiel schräg über die Nase), und das Werkzeug Richtung der Striche  nicht

zur Verfügung steht, können Sie den Wert des Parameters Dichte der Striche ändern, um verschiedene Versionen zu
probieren.

Dichte der Striche = 86;
Intensität der Striche = 5;
Mikrodetail = 15.

Mit helleren Farben wird das Bild besser aussehen:

Sättigung = 25.

Schritt 4. Klicken Sie auf , um das Bild mit den neuen Einstellungen zu bearbeiten. Das Ergebnis wird im Ergebnis-
Register angezeigt.

Ölporträt des Mädchens
Schritt 5. Wir fügen dem Bild einen Namen auf der Registerkarte Text hinzu. Wir können das Bild einrahmen und das
Ölporträt ist fertig.
Schritt 6. Klicken Sie auf , um das Ergebnis anzuwenden und das Plugin zu schließen.
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Ölporträt im Rahmen
(klicken Sie darauf, um das Bild groß zu sehen)
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AKVIS SOFTWARE

 

AKVIS AirBrush — Airbrush-Technik in Fotos

AKVIS AirBrush lässt Ihre Fotos wie mit einer Spritzpistole gezeichnet aussehen. Weiter…

 

AKVIS Artifact Remover AI — JPEG-Kompressionsartefakte beseitigen

AKVIS Artifact Remover AI verwendet fortgeschrittene Algorithmen der künstl ichen Intell igenz, um JPEG-
Kompressionsartefakte zu entfernen und die ursprüngliche Qualität komprimierter Bilder wiederherzustellen. Die Software ist
kostenlos erhältlich. Es ist ein Muss für Heimanwender und Profis. Weiter…

 

AKVIS ArtSuite — Bilderrahmen und Effekte für Ihre Fotos

AKVIS ArtSuite versieht Digitalfotos mit schönen Bilderrahmen. Ein richtig ausgewählter  Bilderrahmen ergänzt Ihr Bild und
bringt es zur besonderen Geltung. 
Das Programm stellt eine große Auswahl unterschiedlichster Rahmen bereit.  Außerdem erlaubt es, eigene Bilder für die
Erstellung des originellen Rahmens zu benutzen. Weiter…
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AKVIS ArtWork — Vielseitige Sammlung von Maltechniken

AKVIS ArtWork imitiert verschiedene Mal- und Zeichentechniken. Das Programm bietet diese Stilmöglichkeiten an: Ölgemälde,
Aquarell, Gouache, Comic, Tintenzeichnung, Linolschnitt, Pastell und Pointill ismus. Ob ein Ölporträt oder eine
Landschaftsmalerei, das Programm wird Ihre Ideen erfolgreich umsetzen. Weiter…

 

AKVIS Chameleon — Erstellung von Fotocollagen

AKVIS Chameleon ist ein wunderbares Programm für Erstellung von Fotocollagen mit automatischer Adaptierung der
eingesetzten Objekte in Bezug auf die Farbe des Hintergrundes sowie deren Kantenglättung. Das Programm erfordert nicht die
exakte Auswahl der Objekte. Kopieren Sie das Objekt, setzen Sie es in das Bild ein, und er adaptiert die Farbskala des Bildes
und seine Ränder glätten sich. Weiter…
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AKVIS Charcoal — Kohle- und Kreidezeichnungen

AKVIS Charcoal ist ein künstlerisches Werkzeug zur Umwandlung von Fotos in Kohle-, Kreide- und Rötelzeichnungen. Weiter…

 

AKVIS Coloriage — Bildeinfärbung und Farbenänderung

AKVIS Coloriage ändert die Farben eines Fotos: von der Einfärbung Schwarz-Weiß-Fotos bis hin zur Farbenänderung auf Ihren
Farbfotos.
Kein Hantieren mit Ebenen - malen Sie einfach ein paar Striche mit den gewünschten Farben und das Programm erledigt den
Rest. Weiter…

 

AKVIS Decorator — Oberflächengestaltung und Farbveränderung

AKVIS Decorator erlaubt es, die Oberfläche eines Objekts zu verändern. Wählen Sie einen Teil des Bildes aus, z.B. das Kleid
eines Mädchens, und wenden neue Texturen darauf an. Das Mädchen bekommt ein geflecktes oder kariertes Kleid, das
aussieht als wäre es aus Samt oder Seide, oder sogar aus Holz oder Süßigkeiten. Weiter…
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AKVIS Draw — Skizzeneffekt in Fotos

AKVIS Draw lässt Fotos wie mit einem Bleistift gezeichnet aussehen. Die Software funktioniert wie ein Kunstfilter, der Fotos in
stilvolle Skizzen durch Anpassung der Einstellungen umwandelt. Weiter…

 

AKVIS Enhancer — Bildkorrektur und Detailoptimierung

AKVIS Enhancer ist ein Werkzeug, um Bilder zu retten, die wegen falscher Belichtung nicht optimal aussehen. Das Programm
gibt Ihnen die Möglichkeit, Details in unterbelichteten und überbelichteten Bereichen eines Fotos aufzudecken. Das Programm
hat drei Modi: Detailoptimierung, Druckvorbereitung und Tonkorrektur. Weiter…

 

AKVIS Explosion — Spektakuläre Explosionseffekte

AKVIS Explosion bietet kreative Zerstörungs- und Explosionseffekte für digitale Fotos. Das Programm imitiert den Sandsturm-
Effekt und fügt Ihren Bildern fliegende Partikel hinzu. Mit der Software können Sie Ihre Entwürfe ganz einfach explodieren
lassen! Weiter…
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AKVIS Frames — Farbenfrohe digitale Fotorahmen

AKVIS Frames ist eine kostenlose Foto-Editing-Software, die speziell für die Arbeit mit Rahmenpaketen von AKVIS entwickelt
wurde. Mit dem Programm können Sie Ihre Fotos mit exklusiven Bilderrahmen schnell und einfach versehen! Weiter…

 

AKVIS HDRFactory — HDR-Bilder: Über die Wirklichkeit hinaus

AKVIS HDRFactory ist ein vielseitiges Programm zum Erstellen von HDR-Bildern sowie für kreative Gestaltung der Fotos.
HDRFactory erstellt HDR aus mehreren Aufnahmen des gleichen Objekts mit unterschiedlichen Belichtungszeiten. HDRFactory
erlaubt es Ihnen, sogar den HDR-Effekt auf einem Bild nachzuahmen. Das Programm kann auch für Fotokorrektur verwendet
werden. Weiter…

 

AKVIS LightShop — Licht- und Sterneneffekte

AKVIS LightShop erlaubt es Ihnen, eine endlose Zahl von erstaunlichen Lichteffekten zu erstellen! Das Programm bietet
fortgeschrittene Techniken zur Erstellung von Sternen- und Lichteffekten auf Ihren Fotos. Ein Lichteffekt kann jedes Foto
beleben und auffrischen. Fügen Sie Ihren Fotos einen Hauch von Magie hinzu! Weiter…
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AKVIS Magnifier AI — Bilder vergrößern und Bildqualität verbessern

Mit AKVIS Magnifier AI können Sie Fotos verlustfrei vergrößern und gleichzeitig die Bildqualität verbessern. Mit innovativen
KI-Algorithmen skaliert Magnifier AI Bilder auf eine superhohe Auflösung von bis zu 800% und erstellt wandgroße Drucke.
Verbessern Sie die Bildauflösung, erstellen Sie detaillierte Bilder ohne Verpixelung oder Unschärfe! Weiter…

 

AKVIS MakeUp — Porträtverbesserung

AKVIS MakeUp ist eine Software zur Porträtverbesserung, die Ihren Fotos einen professionellen Look verleiht.

Die Software verfeinert die Hautstruktur auf Porträtaufnahmen und lässt den Teint strahlen. Es ist schon erstaunlich, wie viel
ein gutes Hautbild zum Verjüngen und Auffrischung des Gesichts beibringen kann. Weiter…

 

AKVIS NatureArt — Natur-Effekte auf digitalen Fotos
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AKVIS NatureArt ist ein ausgezeichnetes Werkzeug zur Nachahmung der Schönheit der Naturphänomene auf Ihren digitalen
Fotos. Das Programm enthält eine ganze Reihe von Effekten: Regen

 

AKVIS Neon — Leuchtbilder aus Fotos

AKVIS Neon ist eine Software zur Umwandlung von Fotos in leuchtende Zeichnungen. Das Programm transformiert Fotos in
Neonbilder, die wie mit fluoreszierenden Farben gezeichnet aussehen. Weiter…

 

AKVIS Noise Buster AI — Verringerung des Bildrauschens

AKVIS Noise Buster AI verringert Rauschen auf digitalen Bildern. Das digitale Rauschen kann als zahlreiche helle, dunkle oder
farbige Bildpunkte auf einfarbigen Flächen auftreten. Nach der Anwendung sehen Ihre Fotos sauber und fehlerfrei aus. Weiter…
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AKVIS OilPaint — Ölgemälde-Effekt

AKVIS OilPaint lässt digitale Fotos wie echte Ölgemälde aussehen. Die geheimnisvolle Herstellung eines Gemäldes geschieht
direkt vor Ihren Augen. Der einzigartige Algorithmus erlaubt es, die Technik eines echten Pinsels authentisch zu reproduzieren.
Mit dieser innovativen Software können Sie ein richtiger Künstler werden! Weiter…

 

AKVIS Pastel — Pastellgemälde aus Fotos

AKVIS Pastel verwandelt Ihre Fotos in Pastellgemälde. Das Programm konvertiert Ihre Bilder in lebensechte digitale
Kunstwerke, indem es eine der beliebtesten künstlerischen Maltechniken imitiert. AKVIS Pastel ist ein leistungsfähiges
Werkzeug, um Ihr kreatives Potenzial zu entdecken und auszuleben! Weiter…

 

AKVIS Points — Pointillismus-Effekt in Fotos

AKVIS Points verwandelt Ihre digitalen Fotos in Gemälde in pointillistischer Malweise. Diese Technik zählt zu einer der
ausdrucksstärksten Stilrichtungen in der Malerei. Entdecken Sie Geheimnisse des Pointillismus mit AKVIS Points! Weiter…
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AKVIS Refocus AI — Scharfstellung und Weichzeichnung

AKVIS Refocus AI stellt verschwommene Bilder scharf. Das Programm kann das ganze Foto oder nur einen ausgewählten Teil
davon in den Fokus stellen, damit das Aufnahmemotiv besser zur Geltung kommt. Außerdem ist es möglich, Bokeh- und
Weichzeichnungseffekte auf Ihre Fotos zu erstellen.

Die Software stellt fünf Modi zur Verfügung:  Scharfstellung AI, Iris-Weichzeichnung, Tilt-Shift, Bewegungsunschärfe und
Radiales Weichzeichnen. Weiter…

 

AKVIS Retoucher — Software zur Fotorestaurierung

AKVIS Retoucher ist eine effektive Fotorestaurierungssoftware für Kratzer-und Staubbeseitigung. 
Die Software hilft nicht nur Kratzer, Risse, Schmutz und sonstige Beschädigungen zu beseitigen, sondern auch die fehlenden
Teile des Fotos zu rekonstruieren, indem die angrenzenden Bereiche zur Wiederherstellung herangezogen werden. Weiter…
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AKVIS Sketch — Fotos in Zeichnungen umwandeln

AKVIS Sketch verwandelt Fotos in hochrealistische Bleistiftzeichnungen. Die Software erstellt wunderschöne S/W und farbige
Zeichnungen, die die Technik der Graphit-, Bleistift-, Kohle-, Pastell- und Aquarellzeichnung nachahmen. Das Programm bietet
folgende Zeichenstile: Klassischen, Künstlerischen, Maestro und Multistil - jeweils mit einer Reihe von Voreinstellungen. Mit
AKVIS Sketch brauchen Sie keinen Bleistift, um sich als Künstler zu fühlen! Weiter…

 

AKVIS SmartMask — Objekte aus Foto ausschneiden

AKVIS SmartMask ist ein Maskierungswerkzeug, das die Auswahl schwieriger Objekte innerhalb weniger Sekunden erlaubt,
ohne sie genau zu markieren.

Nie war die Auswahl so einfach! Weiter…

 

AKVIS Watercolor — Aquarell-Effekt auf Fotos

AKVIS Watercolor verwandelt Fotos in erstaunlich realistische Aquarellbilder. Das Programm bietet zwei Konvertierungsstile:
Klassisches Aquarell und Kontur-Aquarell. Jeder Stil kommt mit einer großen Auswahl an gebrauchsfertigen Presets. Das
Programm erlaubt es, großartige Meisterwerke mit nur einem Klick erstellen! Weiter…
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